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Contacting Infor

If you have questions about Infor products, go to Infor Concierge at https://concierge.infor.com/ and create
a support incident.

The latest documentation is available from docs.infor.com or from the Infor Support Portal. To access
documentation on the Infor Support Portal, select Search > Browse Documentation. We recommend that
you check this portal periodically for updated documentation.

If you have comments about Infor documentation, contact documentation@infor.com.
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Chapter 1: Introduction

Infor CRM SLX is a leading customer relationship management solution that enables small to medium-sized
businesses to acquire, retain, and develop profitable customer relationships through integrated Sales,
Marketing, Customer Service, and Support automation solutions.

Why Use Infor CRM SLX
The Infor CRM SLX Web Client helps you manage all aspects of the sales cycle and the customer relationship
over the Web. In addition to tracking contacts, accounts, opportunities, tickets, and activities, users have
access to tools for reporting, automating processes, and creating e-mails and letters using mail merge.

Key Features
The following key features describe how you can use the Infor CRM SLX Web Client:

• Contact, Account, and Opportunity Views - Use the Contact, Account, and Opportunity views to manage
detailed information about your contacts, accounts, and opportunities.

• Calendar and Activities - Use the Calendar to view open and completed activities and events. Use the
Activities view to manage such daily activities as scheduling phone calls, meetings, and to dos.

• Lookups - Use lookups to search for records or build groups. Lookups enable you to filter your record
list, and then save the results as a new group. Lookup options vary by record type.

• Groups - Use groups to organize your contacts, accounts, opportunities, tickets, and other data based
on common characteristics. Groups can be used for reporting, mail merges, and more.

• Campaigns and Leads - Use Leads to develop and qualify new Contacts and Accounts. Use the Campaign
functions to combine advertising, public relations, sales promotion, and selling activities to achieve sales
or marketing goals.

• Mail Merge - Use Mail Merge when you need to communicate with a group of contacts, accounts,
opportunities, or leads.

• Key Performance Indicators (KPIs) - are defined for some list views. These KPIs are calculated using the
current list of records, based on the group and any filters that have been applied. The KPIs do not display
until you select which KPIs you want to display.
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• Reports and Analysis - Use Reports and filters to summarize information about your contacts, accounts,
opportunities, contracts, and tickets. The Infor CRM SLX Dashboard view allows you to display performance
and analysis information in a dashboard format.

• Customer Service and Support - Use tickets to track, qualify, and resolve customer questions and issues.
You can track time spent working on a ticket through Punch in/Punch out, create ticket activities that
are charged against the customer’s service contract, and schedule calendar activities. The Service and
Support features also provide a means of tracking defects in products or services, and include a return
process.

• Literature Requests - Use literature requests to schedule sending marketing material or other documents
to contacts. Literature requests are generally paper materials that must be mailed.

• Library - Use the Library as a central repository for your company information. The Library often contains
items such as product information, sales literature, and presentations.

• Processes - Use processes to execute a series of tasks in a specific sequence over a set time period. The
Infor CRM SLX Web Client offers Sales Processes and Contact Processes.

About This Guide
The purpose of this guide is to help you begin using the Infor CRM SLX Web Client. This guide uses scenarios
to demonstrate how to use the Infor CRM SLX Web Client for many of your daily tasks.

If your company has customized the Infor CRM SLX Web Client, the number, order, and appearance of dialog
boxes and screens may be different than described. See your system administrator for more information.

Related Documentation
• Infor CRM SLX Quick Reference card provides commonly used buttons, e-mail configuration options, and

tips for working with groups and Outlook Integration. The Infor CRM SLX Quick Reference card is accessible
from the Help menu.

• The Infor CRM SLX Web Client Help provides detailed information about all of the features available over
the Web, including additional information about Send to CRM and Mail Merge.

• Compatibility information for Infor CRM SLX 9.0 is available in the Infor Online Compatibility Matrix (OCM).
1 Sign in to the Infor Concierge Portal web site:https://concierge.infor.com/.
2 Expand the Environment menu, and then click Online Compatibility Matrix.

Click Help for a video explaining the features of the OCM.

Help is available in each Infor CRM SLX application. Additional resources and documentation are available
to Partners and Customers with a valid technical support contract at https://concierge.infor.com/ .
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Chapter 2: Understanding the Infor CRM SLX Web Client
Workspace

Take a few minutes to learn some of the system basics. It will help you become familiar with the workspace
and navigation features.

In this chapter, you will learn to:

• Log on to the the system
• Understand the workspace
• Install and use Infor CRM SLX Mail Merge for Microsoft Word
• Install and use Xbar
• Get more help

Signing in to the Infor CRM SLX Web Client
Before you begin, specify the User ID and password. If you do not have this information, contact the system
administrator.

To log on:

1 Connect to the company's Web Client. If you have Windows Authentication configured, you do not need
to complete the remaining steps, as you can automatically log in to the Infor CRM SLX Web Client. This
can be done several ways, depending on the browser. In many browsers, it is faster to set the initial screen
as the default screen of the browser, or to add the initial screen to a list of favorite sites.

2 Specify the User ID and Password.
Passwords are case-sensitive. In addition, the system administrator can set restrictions on using blank
passwords, the user name as a password, and other options. If necessary, see the system administrator
to discuss the password options.

3 If necessary, change the language setting.
Changing the language can cause the Infor CRM SLX Web Client to display the selected language. If you
do not select a language, then the Infor CRM SLX Web Client uses the default language. The list of languages
is based upon the languages supported by the organization.
Click the drop-down arrow and select a language from the list of supported languages.
Note: If the implementation uses Windows Authentication and you do not sign in to the Infor CRM SLX
Web Client, you can also select a language from the options User Profile tab.
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4 Click Sign In.

To log off: In the lower-right part of the browser window, click Sign Off.

Working in the Infor CRM SLX Web Client
The workspace is the area where various views appear in the main Infor CRM SLX Web Client.

Note: 
Some features require you to enable pop-ups. See the browser help for specific instructions on how to allow
pop-ups.

Understanding the Workspace Features
Each view in the Infor CRM SLX Web Client contains many of the following elements.

Note: 
The assigned workspace can be different depending on the user's access rights or if the installation is
customized.

DescriptionElement

The title identifies the active view. When you are in a detail view, the title bar
displays the name of the current record.

Title Bar
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DescriptionElement

Located on the left side of the Infor CRM SLX Web Client workspace, the Naviga-
tion Bar contains buttons that open the main Infor CRM SLX Web Client views.
The Navigation bar can be docked or hidden. If you cannot see the Navigation

Bar, click the  icon in upper left corner of the workspace.

To dock the Navigation bar, so that it always appears, click the  icon. To hide
the Navigation Bar, click the  icon.
Your administrator can group the buttons into Navigation Group subsets that
focus on specific elements of the business, such as Sales or Support. For exam-
ple, the Support group contains Contacts, Tickets, Defects, Activities, Calendar,
and Reports.
Click the navigation heading to show or hide the items listed below the heading.

Navigation Bar

The menu bar contains the Infor CRM SLX Web Client commands. These include
Recently Viewed, New, Schedule, Log, Tools, Compose, Theme, Job Notification ,
Past Due , Alerts , Job Notification , SpeedSearch, and the Help button. Click a
menu to expand it.

Menu Bar

The Lookup button, located to the left of the group tabs in most list and detail
views, allows you search from records using one or more search conditions.

Lookup

SpeedSearch helps you find information stored in the Infor CRM SLX database.
For example, you can search through existing tickets or procedures to help
solve a customer's problem, or search for a specific document, like a sales
presentation.

Speed Search

Tabs organize information on many of the list views, detail views and dialog
boxes.

Tabs

A pick list is a set of values you can select from when entering data. Pick lists
are useful because they encourage consistent data entry. Your access rights
determine if you can add, edit, or delete pick list items. To open a pick list, click
the drop-down arrow in the box.

Pick Lists

The Task Pane displays to the right of the main window pane. The Task Pane
consists of filters, common tasks and other features designed to help you
complete your work. The available options depend on the record type and type
of view where you are working.

Task Pane

The status bar displays the user, date, time zone and Log Off button.Status Bar

Setting Themes and Modes
Use the Themes menu to personalize the appearance of your workspace.
1 Select Theme from the menu bar.
2 Perform one of these:
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• Navigate to Modes and select Light, Dark, or High Contrast. This option determines text and
background appearance.

• Point to Colors and select a color theme. The color theme determines the menu bar, title bar, section
headings, and highlight colors.
These settings can be used until browser cache is cleared.

Using List Views
List views display information in a list with columns and rows of information. Each tab in the list view contains
a group of contacts, accounts, opportunities, or tickets and so on.

• You can customize the list view groups by adding or removing columns, changing the column order and
adjusting column widths.
Note: See "Customizing List View Groups" in the Web Client online Help for more information.

• Clicking a column header sorts the information in that column. The arrow marker indicates whether the
column is ascending or descending.

• Key Performance Indicators, or KPIs are defined for some list views. These KPIs are calculated using the
current list of records, based on the group and any filters that have been applied. The KPIs are not
displayed until you select the KPIs you want to display. To select KPIs, click the Manage KPIs icon , select
the check boxes of the KPIs to be displayed and click Save. For more information, see Working with List
View KPIs on page 67.
If KPIs are not available on the list view, No metrics defined for this list view message is displayed.

Using Detail Views
Most records in Infor CRM SLX display information in both a List view and a Detail view. The Detail view consists
of information boxes, tabs, and a user-defined middle section.
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• The upper section shows basic information about the selected record. When you add a new record, dialog
boxes guide you through entering the information that appears in the Detail view. To edit information,
click the box you want to change.

• The middle section is called the user-defined area. You can use this area to keep the tab you use most
often visible. To move a tab to the middle section, click one of the tabs in the bottom section, hold the
mouse button, and drag the tab to this area. The tab is displayed in the user-defined area each time you
use the Infor CRM SLX Web Client. If you want to change the tab in the middle section, select another tab
and drag it to replace the current tab.

• The lower section contains a group of tabs. Each tab shows specific information you need for the related
record. The system administrator can create custom tabs for the assigned company. Click the  and
select the check box of the columns you want to appear in the grid and clear the check boxes of the
columns you want to hide in the grid. When finished, move your mouse cursor off of the menu and click
to close the menu.

Understanding the Available Buttons
Many features in the Infor CRM SLX Web Client are accessed through buttons. The following list shows each
of the buttons available, and describes the action each button performs. When you drag the mouse across a
button in the Infor CRM SLX Web Client, a tool tip explaining the button function appears. Buttons are referred
to by the respective tool tip.

EventTool tip or Descrip-
tion

Button

Indicates an activity has been accepted.Accepted

Click this button to open the Account Service Information dialog
box.

Account Service infor-
mation
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EventTool tip or Descrip-
tion

Button

Click this button to add or associate an item.Add, Associate

Click this button to add another parameter to the Lookup on the
List or Detail views.

Add Condition

Click this button to add a custom product to a sales order or
quote.

Add Custom Product

Click this button to attach a file.Add File

Click this button to attach a Web address URL.Add URL

Click this button to view activities with triggered alarms and un-
confirmed activities.

Alerts

Infor Ming.le only. Available from the left side of the Infor Ming.le
toolbar. Use this menu to select another Infor application.

App Menu

Click this button to associate an item.Associate

Infor Ming.le only. Available from the Infor Ming.le toolbar. Dis-
plays the Bookmark menu where you can put a "bookmark" on
the current view for quick access, manage your bookmarks, or
view a list of your bookmarks.

Bookmarks

Click this button to select a date and time.Calendar

Click this button to take a forecast snapshot.Camera

Click this button to clear a lookup selection.Clear

Click this button to hide additional information in a list row.Collapse

Click this button to complete an activity.Complete

Click this button to copy contact information to the Clipboard.Copy Information to
the Clipboard

Indicates an activity has been declined.Declined

Click this button to delete or disassociate an item.Delete or Remove

Click to create a copy of a record to create a new record.Duplicate

Click this button to edit information.Edit

Click this button to open the Web Form Designer. Only users with
the appropriate role can access this feature.

Edit Form

Click this button to open a multi-select pick list.Ellipsis
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EventTool tip or Descrip-
tion

Button

Click this button to open a new e-mail message.Email

Click this button to view additional information in a list row.Expand

Click this button to filter a list of records.Filter

Click this button to perform a lookup.Find

Click this button to view the first record in a group.First

Click this button to open Web Client Help.Help

Click the drop-down arrow to display notification details and to
access the result of the assigned job. The number next to the icon
shows the number of jobs that are available to view.

Job Notification

Click this button to view the last record in a group.Last

Click this button to switch to the list view.List View

Click this button to open MapQuest using the current address
information.

Map

Click this button if you find a solution helpful, but are not pasting
it into the assigned ticket.

Mark this item as
useful

Click this button to maximize the size oMaximize pane

Identifies a meeting, or click this button to schedule a meeting
from the Activities tab.

Meeting

Click this button to minimize the size of the window pane.Minimize pane

Click this button to move a contact to a different account.Move

Click this button to view the next record.Next

Click this button to open the Activities view Past Due tab.Past Due

Identifies a personal activity, or click this button to schedule a
meeting from the Activities tab.

Personal Activity

Identifies a phone call, or click this button to schedule a meeting
from the Activities tab.

Phone call

Click this button to view the previous record.Previous

Identifies that an activity is part of a recurring activity series.Recurring

Click this button to refresh the list of records in a list view.Refresh
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EventTool tip or Descrip-
tion

Button

Click this button to remove a parameter from the Lookup on the
List or Detail views.

Remove Condition

Click this button to clear any changes that you have made since
the last update.

Reset

Click this button to save the changes.Save

Click this button to save the current record and clear the informa-
tion in order to insert a new record.

Save & Clear

Click this button to save the current record and retain the account
information.

Save & New

Infor Ming.le only. Available from the Infor Ming.le toolbar. Opens
Infor Ming.le search.

Search

Click this button to open an email message with the contents of
the note or history copied and pasted in the message.

Send to Email

Click this button to open a Microsoft Word document with the
contents of the note or history copied and pasted in the docu-
ment.

Send to Word

Infor Ming.le only. Available from the Infor Ming.le toolbar. Click
this button to share the current record or view with Infor Ming.le.

Share

Click this button to open SpeedSearch.SpeedSearch

Click to start a manual synchronization or enable synchronization.Sync or
Sync Enable

Click to disable synchronization.Sync Disable

Identifies a to do, or click this button to schedule a meeting from
the Activities tab.

To Do

Indicates an activity has not been accepted or declined.Unconfirmed

Click to update the campaign target list.Update Target

Infor Ming.le only. Available from the Infor Ming.le toolbar. Dis-
plays the Infor Ming.le user profile menu to access Infor Ming.le
Alerts, Tasks, Notifications, Posts, Admin Settings, User Settings,
User Management, Mobile Apps, Help, and About, and to sign out
of your Infor Ming.le session.

User

Click this button to put a user name and date stamp in the as-
signed ticket notes.

User Date Stamp

Click to view an account’s parent and child relationships to other
accounts.

View Parent/Child
Hierarchy
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EventTool tip or Descrip-
tion

Button

Click this button to go to the account's Web site.WWW

Getting Help
Information on advanced features and areas not covered in this guide is available in the Infor CRM SLX Web
Client online Help topics.

To access online Help:

Click the Help button .

Topic NameWhat do you want to do?

Logging on to the Infor CRM SLX Web ClientLog on to the Infor CRM SLX Web Client.

What’s New in This ReleaseFind out what new features have been added to the
Infor CRM SLX Web Client.

New User TipsFind useful tips for first-time users.

Using AlertsUse Alerts to help me manage my activities.

Editing User OptionsCustomize the Infor CRM SLX Web Client options for
my personal needs.

Scheduling or Editing an ActivitySchedule a meeting and invite others.

Scheduling or Editing an EventSchedule an Event (such as a trade show).

What are Sales Processes?Access an overview of Sales Processes.

Adding or Editing a Response InformationAdd a campaign response for a campaign target

In addition to the Help, you can find more information from the following sources:

System Administrator, See the system administrator for answers specific to the Infor CRM SLX installation.

Understanding Infor CRM SLX Mail Merge for Microsoft
Word
The Infor CRM SLX Mail Merge for Microsoft Word add-in provides support for Mail Merge in Microsoft Word,
including creating and managing templates and performing mail merges output to file, print, or email.
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Installing Mail Merge for Microsoft Word
Before you can use Mail Merge for Microsoft Word you must install the Infor CRM SLX Mail Merge for Microsoft
Word add-in.

To install Integration:

1 Close Microsoft Word.
2 On the Tools menu, click Options.
3 Click the General tab.
4 Click Install Mail Merge for Microsoft Word.
5 Open the InforCRMWordAddinSetup.exe from your Downloads folder.
6 Select the I agree to the license terms and conditions check box.
7 Click Install.
8 If prompted, click Yes to confirm that you want to install the add-in.
9 Click Close.
10 Open Microsoft Word.
11 If prompted "Are you sure you want to install this customization?”, click Install.
12 Once installed, you must set Infor CRM SLX Options.

Setting Infor CRM SLX Database Connection Options
Use the Connection options to set up your connection to the Infor CRM SLX server.

Note: These options are configured for users who set these options for Infor CRM SLX Xbar for Microsoft
Outlook.

To set options:

1 In Microsoft Word, on the Mailings tab, click the Infor CRM SLX Options button and, if necessary, click
Connection.

2 In the SData URL field, specify the server name and SData portal.
• Specify the SData URL that your administrator provided in order to connect to Infor CRM SLX. Use

the following format: http://servername:port/sdata or https://servername:port/sdata
• Offline Web Client users - Specify the URL to connect to your local Infor CRM SLX server. Use the

following format: http://localhost:port/Sdata The port is usually 8088.

3 If your implementation does not use the standard SlxClient portal for the Web Client, then in the Web
Client URL field, specify the server name and Web Client portal. This is automatically completed for you
if your implementation uses the standard SlxClient portal, and no changes are needed.
• Specify the URL that your administrator provided in order to connect to the Infor CRM SLX Web Client.

Use the following format: http://servername:port/<portal name> or https://servername:port/<portal
name>

• Offline Web Client users - Specify the URL to connect to your local Infor CRM SLX Web Client Use the
following format: http://localhost:port/<portal name> The port is usually 8088.
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This is automatically completed for you if your implementation uses the standard SlxClient portal, and
no changes are needed.

4 If you use your Windows account information to log in to Infor CRM SLX, select the Use Windows
Authentication option, otherwise leave this option cleared.

5 Specify the User Name and Password you use to sign in to Infor CRM SLX. This is your Infor CRM SLX or
Windows user name and password.
Note: If your implementation uses Ming.le, you must not enter your credentials in this dialog box. You
are prompted to enter your Ming.le credentials.

6 Click Test. If the test fails, review your connection information. If the information is correct and you still
cannot connect, contact the administrator.

7 Click OK when you are finished setting your options and your connection test is successful.

Understanding Infor CRM SLX Integration with Microsoft
Outlook
Note: Outlook Integration features are now installed with Infor CRM Xbar for Microsoft Outlook.

The Infor CRM Xbar for Microsoft Outlook installation provides support for:

• Xbar
• Access key contact information, activities and opportunities in Infor CRM from Outlook e-mail

correspondence or calendar activities.
• Create new contacts, accounts and opportunities by dragging and dropping existing information

from e-mail into the Xbar interface.
• Make changes to contact, calendar, and interaction history in Xbar that automatically updates within

Infor CRM.
For more information about Xbar for Outlook features, please refer to the Xbar help. Click the icon

to  open the Global menu and access the help file.

• Outlook Integration
• Record email messages to history
• Integrate with the Microsoft Outlook Address Book
• Drag and Drop Email from Microsoft Outlook
• Send an Infor CRM contact's information in a vCard file format via email
• Attach documents from Infor CRM Library to a message in Outlook

• Infor CRM Activity Task Pane
• Using Outlook Synchronization allows you to synchronize:

• Contacts
• Calendar
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Installing Infor CRM Xbar for Microsoft Outlook
Outlook Integration features are now installed with Xbar. Before you can use any of these features you must
install Infor CRM Xbar for Outlook.

To install Infor CRM Xbar for Microsoft Outlook from the Infor CRM Web Client:

1 Infor CRM recommends closing Outlook.
2 Sign in to the Infor CRM Web Client.
3 On the Tools menu, click Options.
4 Click the General tab.
5 Click Install Xbar for Outlook.
6 If prompted, click Save File, go to the downloads location, and click the Infor CRM XBar Setup.exe.
7 If prompted, click Run.
8 Click Install.
9 Click Close.
10 Open Outlook.
11 If prompted to use the Infor CRM Connector in Outlook, click Yes.

The Infor CRM Connector Options dialog box opens.

12 If necessary, configure your Infor CRM Connector options.

Configuring Outlook Integration
Outlook integration preferences must be configured in Microsoft Outlook.

Before you can configure Outlook:

• Microsoft Outlook must be installed and running on the local machine.
• Web - Infor CRM SLX Xbar cannot be installed unless Microsoft Office, including Outlook, is already

installed.
• Advanced - To enable drag and drop from Outlook to Infor CRM SLX Web Client using all browsers.

• You must know the connection server and port number and the user name and password. Contact the
system administrator for more information.

To configure:

1 Open Microsoft Outlook.
2 If you are not prompted, click the Options button.

If the Options button does not appear, then Outlook sync is not installed properly.

3 Use the tabs to set the following options:
• Connection - connection to the Infor CRM SLX server. Required for contact and calendar

synchronization and e-mail integration.
• Note: These options are shared with the Infor CRM SLX Mail Merge for Microsoft Word add-in and

may already be configured if you previously set these options for the add-in.
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• Xbar side Panel - Set options specific to Infor CRM SLX Xbar For Microsoft Outlook.
• Send to CRM/Record to History - options for prompts, displaying information, and attachment

behavior when using Send to CRM or Record to History. Used for e-mail integration.
• Advanced - To enable drag and drop from Outlook to Infor CRM SLX Web Client using all browsers,

when your version of Infor CRM SLX is 8.3.0.4 or later.
• All Options - ability to view options as value pairs. Recommended for advanced users only.

For more information see the Outlook Sync help topic "Configuring Outlook Sync".

4 Click OK.
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Chapter 3: Managing Contacts and Accounts

This chapter introduces you to the core of Customer Relationship Management (CRM) - working with contacts
and accounts.

• Contacts are the key people associated with an account.
• Accounts are your prospective customers. Accounts can contain one or many contacts.

You can use Infor CRM SLX to manage contact and account information. This includes daily interactions, such
as phone calls, meetings, action items, or other correspondence.

In this chapter, you will learn to:

• Add a contact and an account
• Create an account association
• Use the Library
• Schedule a literature request
• Add a note and schedule a follow-up activity

Adding a Contact and Account
Infor CRM SLX focuses on account relationships. Therefore, all contacts must be attached to an account.
Account and contact information is accessible by any Infor CRM SLX user who has the appropriate security.
For example, you can create an account for Beeker Motors. The Sales Assistant may not have the required
security to access the account, but the Sales Manager can.

Understanding Account Ownership
Before creating an account in Infor, it is important to understand account ownership.

• The Account Owner has access to an account and can use any account-related activities such as scheduling
activities and running reports. An account owner can be an individual user, a team, or all Infor CRM users.
Access to account data can be different for each user. For example, if a team owns an account, some
team members may have read-only access to the account, while others have read/write access. Security
is controlled by the system administrator.
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• The Account Manager is responsible for managing the relationship with the account. This can include
follow-up phone calls, meetings, preparing proposals, and working with the account’s contacts. The
account manager is a single individual.

The individual user designated as the account owner is often also set as the account manager. If a team is
the account owner, a team member can be assigned as the account manager. Account owners and managers
must be assigned according to the company’s guidelines.

There are several ways to add contacts and accounts to Infor CRM. This guide explains the most common
methods.

Our scenario:

You met Tom Dale and Joan Smith at a trade show. Tom and Joan (contacts) work for Beeker Motors (account).
First you must add contact Tom Dale to a new account (Beeker Motors); then add Joan Smith to an existing
account (Beeker Motors).

To add contacts and an account:

1 On the New menu, click Account/Contact.
2 In the Contact field, specify Tom Dale.

To add hyphenated last names or names with a professional designation, click the Edit button next to
the Contact box. Then use the Edit Name dialog box to specify a name prefix (such as Dr.), first name,
middle name, last name, or suffix (such as C.P.A).

3 In the Account field, specify Beeker Motors.
4 In the E-mail and Web boxes, add e-mail and Web address information.

• E-mail - tom.dale@beeker.mail
• Web: www.beeker.web

5 In the Work Phone field, specify 5551234512.
6 Click the Look for Matching Records button.

This searches the database for records that have the same e-mail address, Web address, phone number,
and account. It is important to search for records before adding information. If you do not check for
existing information, you might create a duplicate contact or account.

7 Click Cancel to close the Matching Records dialog box, or if a duplicate record is found click Open next
to a record to view additional details or Use Account to select a record.
If you select Use Account, the account appears next to the Use Existing Account... label in the Insert
Contact/Account view.

8 In the Contact Information area, in the Title field, click the drop-down arrow and select Vice President.
9 Continue to add Tom’s information in the Contact Information section.
10 Under Account Information, double-click in the Address field to open the Address dialog box and add

the Address information for Beeker Motors, as follows:
• Leave Description as Office.
• Select Primary to identify this address as the primary address for this account.
• Click the Address Type drop-down arrow and select Billing & Shipping.
• In the Address 1 field, specify 1234 Gary Parkway.
• In City, State, Postal Code type Oak Park, IL 60305.
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11 Click OK.
12 In the Main field, specify 5551234500.
13 (Optional) Use the MapQuest icon to see a map of the address.
14 Click the Type drop-down arrow and select Customer.
15 Click the Status drop-down arrow and select Active.
16 Click the Industry drop-down arrow and select Automotive/Aerospace.
17 In the Account Manager field, click the Find button, and then select the account manager.
18 In the Owner field, click the Find button, and then select an owner.
19 In the Lead Source field, click the Find button, in the third field, specify tr, click Search, select Trade

Show and then click OK.
20 Click the Save & New button.

This option allows you to add another contact to the existing account.

21 In the Contact field, specify Joan Smith.
22 In the E-mail and Work Phone fields, add e-mail and Work Phone information.

• E-mail - joan.smith@beeker.mail
• Work Phone - 5551234519

23 In the Contact Information area, in the Title field, click the drop-down arrow and select Managing
Director.

24 Click Save.
For more information see the "Adding a New Contact and Account" topic in the Infor CRM Web Client
Help.
If you need to edit a contact or account’s information, you can do so by clicking the fields on the Detail
view and typing in the changes.
Note: You must click the Save button after making any changes.

Adding an Account Association
Accounts may have a common connection, for example, one company may be a parent of another. You can
create a relationship between accounts by adding an association. This association can be helpful for tasks
like running reports. You can create one report for both accounts rather than two separate reports. Associations
can also create opportunities for you to sell to parent companies rather than subsidiaries.

Our scenario:

Tom Dale told you that Beeker Motors was owned by International Machines. You want to create a
parent/subsidiary relationship between the two accounts.

To associate accounts:

1 Open the Beeker Motors Account Detail view.
a On the Navigation Bar, click Accounts.
b Click the Lookup tab (magnifying glass).
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c In the first field select Account, in the second field select Starting With, in the third field specify Be,
and then click Search.

d In the list, click Beeker Motors.

2 On the Beeker Motors Account Detail view, click the Associations tab. If the tab is not visible, click the
More Tabs tab.

3 Click the Add Association button.
4 Click the Find button (magnifying glass).
5 In the Lookup Account box, ensure the Lookup Accounts by: shows Account, specify Int, and then click

the Search button.
6 Click International Machines in the account list, and then click OK.
7 Click the drop-down arrow below Beeker Motors is a and select Subsidiary.
8 Click the drop-down arrow below International Machines is a and select Parent.
9 In the Description boxes, type a description for each account.
10 Click OK.

Working with the Library
The Library is a central repository for company information. Files are organized into folders and sorted by
name. Click the column headings to sort the library files list.

Your company’s library includes product information, policies and procedures, presentations, Web addresses,
and so forth. Only the administrator and an administrative user can add files to the Library.

Our scenario:

You want to use the Library to find current product information.

To access information from the Library:

1 On the Navigation Bar, click Library.
2 In the tree view, click the + signs to expand the folder that contains the file you want to open.
3 In the list, click the File name of the file you want to download.
4 Do one of the following:

a Open the file.
b Save the file.
For more information see the Working with the Library topic in the Infor CRM SLX Web Client Help.
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Requesting Literature for a Contact
Literature requests involve sending marketing materials or other company documents to one or more contacts.
Infor CRM users or the system administrator manage the available literature. After you schedule a request,
the person or group at your company responsible for literature fulfillment can fulfill and complete the request.

If you are making the request for a single contact, select the contact before you begin the following steps.

Our scenario:

Joan Smith requested information on a specific product at a trade show, but you had run out of brochures.
You want to schedule a literature request to send the information to Joan.

To schedule:

1 Open Joan Smith’s Contact Detail view.
a On the Navigation Bar, click Contacts.
b Click the Latest Contacts group tab.
c In the Task Pane, under Filters, click Name and select S.
d In the list, click Smith, Joan.

2 On the Schedule menu, click Literature Request.
3 In the Description field, enter a brief description of the literature request.

a Type Lenovo ThinkPad sales brochure.

4 Click the Send by Calendar button, select a date, and then click OK.
5 In the Send via (delivery method), and Priority fields, click the drop-down arrow, select FedEx and Medium.
6 Under Print Literature List, select with cover letter.
7 Click the Cover Find button, expand Public Templates, expand Letter, select Company Information,

and the click OK.
8 Under Available Items, select the items you want to include in your request.

a If necessary, click the Filter available items button and enter any characters contained in the family,
number or name of the item you want to add.

b Select Lenovo ThinkPad Brochure.
c Double-click in the Quantity column and type the number of copies of that item you want to request.

Type 2.

9 Click the Schedule Literature Request button.
The literature request is recorded in the Literature view and on the Literature Requests tabs in the
Contact and Account Detail views.
The person assigned by the administrator to monitor Literature Requests receives the request and must
fulfill the same by the date you specified.
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Scheduling a Follow-up Activity
In Infor CRM SLX, phone calls, meetings, to-dos, and personal appointments are called activities. Scheduling
follow-up activities can help you organize and remember important events.

Our scenario:

You want to schedule a phone call to follow-up on literature that was sent to Joan Smith.

To schedule a phone call:

1 Open Joan Smith’s Contact Detail view.
2 On the Schedule menu, click Phone Call.
3 In the Regarding field, click the drop-down arrow, and select Confirm Literature Received.
4 Use the Location field to specify a location.
5 In the Start Time field, click the Calendar button to select the date and time to start the activity and

then click OK.
6 Do one of the following:

a Select the Timeless check box to create an activity that occurs on a specific date, but at no specific
time and without a specific duration. Timeless activities are displayed on the Calendar day view.

b In the Duration field, specify or click the drop-down arrow and select from the list.

7 Select the Alarm check box to set an alarm to notify you before the activity begins. Type or select a length
of time.

8 Verify that your name is in the Leader field.
9 In the Notes field, specify Follow-up call for Joan Smith’s literature request.
10 Under Associations, click the drop-down arrow and select Contact, and then click the Add activity

association icon.
11 Select Joan Smith and then click OK.
12 When prompted, click Yes to add Joan Smith as an attendee.
13 Click the Attendees tab and note that Joan Smith is listed.
14 To also add Tom Dale as an attendee, click the Add Contact icon, select Tom Dale from the lookup, click

Add Selected, and then click Close to close the lookup. Tom Dale is now listed as an attendee and
automatically listed under Associations on the General tab.

15 Click the Availability tab to make sure you are available at the selected Start Time and or to add resources
or other members.
Note: You can only add members or resources to phone calls and meetings.

16 Click OK.
You can view the scheduled phone call in the Contact and Account Detail views (on the Activities tab), in
the Activities view (on the All Open and My Activities tabs), and in the Calendar view.
For more information see the Scheduling or Editing an Activity topic in the Infor CRM SLX Web Client Help.
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Adding a Note
You use notes to document the outcome of an activity and to record interactions with an account, contact,
lead, or opportunity. The notes you add appear in the Notes/History tab on the Account, Contact, Lead, and
Opportunity Detail views.

There are several ways to add a note. One method was chosen for the example below.

Our scenario:

You found Tom Dale’s business card while cleaning out your briefcase. You had a note on the back indicating
Tom was interested in a support contract for any products his company purchased. You want to add this
information to Infor CRM SLX.

To add a note:

1 Open Tom Dale’s Contact Detail view.
2 On the New menu, click Note.
3 In the Regarding field, specify Business card notes.
4 In the Location field, specify 2017 Trade Show.
5 If necessary, modify the Completed and Scheduled dates. To modify the date, click the Calendar button

to select the date.
6 Leave Timeless selected since you do not need to enter a duration for the note.
7 Under Associations, note that Tom Dale and Beeker Motors are already listed.
8 Verify that the name is in the Leader field.
9 In the Notes field, type the information on the business card.
10 If necessary, click the Attachments tab to add a document or URL.
11 Click the Follow-up drop-down arrow and select the follow-up activity type. Select To-Do. Schedule a

follow-up activity.
12 Use the Carry Over Notes or Carry Over Attachments check boxes to copy notes or attachments from

this note to the follow-up activity.
13 Click OK.
14 In the Schedule To-Do dialog field, schedule an activity for today.

a For the Regarding field, specify Research.
b In the Notes field, specify Research a support contract for Beeker Motors.
c Click OK to schedule the activity.
You can view notes on the Notes/History tab of the Contact, Account, Lead, and Opportunity Detail
views. In addition, the Notes/History tab allows you to view and filter notes and other history items.
Note: For more information see the Adding a Note topic in the Infor CRM SLX Web Client Help.
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Chapter 4: Managing Your Sales Activities

Infor CRM SLX helps you manage scheduled or unscheduled daily activities. Scheduled activities include
phone calls, meetings, to-dos, and appointments. Unscheduled activities, such as returning a phone call or
answering e-mail, may occur several times a day.

In this chapter, you will learn to:

• Use Alerts
• Complete an unscheduled activity and schedule a meeting
• Use the Calendar and Activities views
• View the history of an account

Using Activities and Events
Activities and Events provide a way to stay on top of your work responsibilities.

• Events usually span several days and might include trade shows, business trips and conferences.
• Activities include placing phone calls, attending meetings, and to do's, such as sending correspondence

or preparing presentations.
• Activities can be associated with other records such as contacts, accounts, leads, opportunities, tickets,

quotes, sales orders and others. Activities are generally scheduled for a specific time, but can also be
scheduled as "timeless" activities. Completed activities become history items.

• You can schedule activities during an event, such as setting up various appointments and meetings for
a business trip.

When you schedule an activity, it displays on the Calendar, Activities view, and in the Activities tab on the
associated detail views. Events display on the Activities view, Events tab and Calendar as well. The Infor CRM
SLX Web Client includes an Alerts feature that alerts you to overdue activities and new activities that you have
yet to confirm.

Several activity types are available to accommodate your work requirements. For instance, you can create
general activities, recurring activities and more. In general, you can edit, delete, or complete activities and
events that you create.
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Using Alerts
Alerts help you keep track of activities with triggered alarms and unconfirmed activities. Your Alerts options
determine how you will be alerted for alarms and new unconfirmed activities.

You can snooze or dismiss selected activity alarms, or snooze or dismiss all of your alarms. You can also view
Activity details and accept or decline unconfirmed activities.

• To view Alerts: If the Alerts notification appears in your menu bar, click the drop-down arrow to display
Alerts details.
Note: If the Alerts notification does not appear in your menu bar, then either you have no current alerts
or your Alerts options may need to be changed.

• To minimize Alerts: If you want to hide your active Alerts, click the drop-down arrow in the Alerts area of
the menu bar. The Alerts view will remain minimized until you click the drop-down arrow again or you
receive a new alert.

Alerts - Alarms Tab
The Alarms tab in the Alerts view lists activities with active alarms. You can snooze or dismiss alarms or view,
complete or delete activities from the Alarms tab.

• To snooze alarms:
1 Select the check box for each activity alarm you want to snooze.
2 Select a time increment in the Snooze by field, and then do one of the following:

• Click Snooze to snooze any selected activity alarms.
• Click Snooze All to snooze all of the activity alarms, if not selected.

• To dismiss alarms, do one of the following:
• Select the check box for each alarm you want to dismiss, and then click Dismiss.
• To dismiss all alarms, click Dismiss All.

• To go to the activity detail view: Click the Activity Type and regarding information that appears in blue
text next to the activity icon. The Alerts are hidden and the activity detail view opens.

• To go to view contact, account, or lead details: To open the detail view, click the record name.
• To complete activities:

1 Select the check box for each activity you want to complete.
2 Click the Complete selected activities button in the top part of the view.

• To delete activities:
1 Select the check box for each activity you want to delete.
2 Click the Delete Selected button in the top part of the view.
3 Click OK to confirm the deletions.

Alerts - Unconfirmed Tab
An unconfirmed activity is an activity notification that you need to confirm or decline.
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• To view unconfirmed activity details: Click the Activity Type and regarding information that appears in
blue text next to the activity icon. Your Alerts are hidden and the activity detail view opens.

• To accept or decline an unconfirmed activity:
1 In the grid, click the unconfirmed activity that you want to accept or decline.
2 Do one of the following:

• Click Accept to confirm that you will attend a phone call or meeting.
• Click Decline to confirm that you will not attend a phone call or meeting.

• To go to the Calendar view: Click the Show Calendar link at the bottom of the view.
• To go to the Confirmations tab on the Activity view: Click the Show Confirmations link at the bottom of

the view.

Completing an Unscheduled Activity
Unscheduled activities can occur unexpectedly throughout the day. It is a good idea to keep Infor CRM SLX
open at all times so you can quickly access contact and account information. After you respond to an
unscheduled activity, you must complete the activity in Infor CRM SLX to create a record of the interaction
with the contact or account.

When you complete an activity, details are recorded on the Notes/History tab for each associated record.

Our scenario:

You received an unexpected call from Tom Dale about a sales opportunity. You need to complete an activity
for the unscheduled phone call and schedule a follow-up meeting.

There are several ways to complete an activity in Infor CRM SLX. The following method allows you to complete
the activity, schedule a follow-up meeting, and carry over the notes.

To complete an unscheduled activity:

1 Open Tom Dale’s Contact Detail view.
2 On the Schedule menu, select Complete an Activity.
3 Select the Create a New Unscheduled Activity to Complete option.
4 Select Phone Call, and then click Continue.
5 In the Regarding field, click the drop-down arrow and select Discuss Opportunities from the list.
6 The Completed and Scheduled fields, display the current date and time. You can accept the default, or

select a new date and time.
7 In the Notes field, specify Tom Dale called about a possible sales opportunity.
8 To schedule a follow-up activity.

a Click the Follow-up drop-down arrow and select Meeting.
b Select Carry Over Notes to include the notes in the follow-up activity.

9 Under Associations, note that Tom Dale and Beeker Motors are already listed.
10 Add the opportunity.

Note: When you add an association, the activity appears on the Activities tab on the associated detail
view.

Getting Started with the Infor CRM SLX Web Client | 31

 

Managing Your Sales Activities



a Click the drop-down arrow, select Opportunity, and then click the Add activity association icon.
b Use the Lookup to find the opportunity you want to associate with the activity, and then click OK.

Note: When you associate a record, related records may be associated automatically. For example,
when associating an opportunity, the related account will also be associated. To remove the
associated record, click the (Delete) icon.

11 Click Now to complete the unscheduled activity.
12 In the Schedule Meeting dialog box, verify that the Notes field includes the notes from the phone call.
13 Select a date and time for the meeting.
14 You also want to include Joan Smith for this call, so under Associations, click the drop-down arrow,

select Contact, and then click the Add activity association icon. Select Joan Smith and then click OK.
15 When prompted, click Yes to add Joan Smith as an attendee.
16 Click the Attendees tab and note that Joan Smith is listed.
17 Click OK to schedule the follow-up meeting.

Note: For more information see the "Completing an Activity" topic in the Infor CRM SLX Web Client Help.

Inviting Others to a Meeting
When you schedule or edit a meeting or a phone call in the Infor CRM SLX Web Client, you can include other
Infor CRM SLX users in the activity. These types of appointments appear on the Confirmations tab in the
Activities view. You can accept or decline activities listed on the Confirmations tab. You may also receive
an alert when you have an unconfirmed activity.

Our scenario:

You want to invite a co-worker (from your company) to your meeting with Tom Dale (a contact for Beeker
Motors).

To invite others to a meeting:

1 Open Tom Dale’s Contact Detail view.
2 Click the Activities tab.
3 In the list, open the meeting you scheduled in the previous scenario.
4 Click the Availability tab.
5 Click the Add Members and Resources button.
6 In the Add Members and Resources list, click Search, select a user, then press the CTRL key and select

Conference Room 100, and then click Add Selected.
Note: You can use the Lookup by fields to narrow the list of users and resources.

7 View the Availability tab grid to make sure you, the other user, and the conference room are available
for the meeting time.

8 Click OK.
The other user will receive an Alert to confirm the activity. After the user confirms or declines the meeting,
you will receive a confirmation of the response.
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Note:  For more information see the "Scheduling or Editing an Activity " topic in the Infor CRM SLX Web
Client Help.

Using the Calendar
Use the Calendar to manage your time and keep track of scheduled activities and events. The Infor CRM SLX
Calendar displays both open and completed activities and events, depending on your calendar options. You
can view your schedule by the day, week, or month view. Use the calendar right-click menu to schedule, edit,
complete, or delete activities and events.

Your calendar security determines whose activities you can schedule, view, edit, complete or delete.

Depending on your access rights, you can view the calendars and activities of other Infor CRM SLX users. Each
user has an assigned color to help identify which activities are for each user.

Note: Some icons are not appeared in week and month views due to limited space.

Our Scenario: You want to check your calendar to see if you have time available to meet with your co-worker
before the meeting with Tom Dale.

To view the calendar:

1 On the Navigation Bar, click Calendar.
2 Select the type of calendar to view.

• Day View - Displays a timeline for the day. Lists all scheduled activities and events for that day.
• Week View - Displays each day in the selected week. Lists scheduled activities and events for each

day.
• Month View - Displays month calendar, listing scheduled activities for each day.
• Work Week View - Displays only the days in your work week as defined in your user options. Lists

scheduled activities and events for each day.

3 Each scheduled activity in the calendar is a link to the activity detail view. Rest your mouse over the
activity to view its details. Click a link to open the selected activity.

4 To view another user's calendar, select the user's name from the Calendar Users list.
Note: For more information see the "Using the Calendar" topic in the Infor CRM SLX Web Client Help.

Using the Activities View
Use the Activities view to manage the scheduled activities and confirmations. If you have additional access
rights, you can also view other Infor CRM SLX users' activities.

The tabs that appear in the Activities view are:

Past DueAll OpenMy Activities
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ConfirmationsUnconfirmedAlarms

The following icons provide information about the activity:

DescriptionIcon

Phone Call

Meeting

To-Do

Personal Activity

The activity is unconfirmed. (Not available on all tabs)

The activity has an attachment

The activity is a single occurrence of a recurring activity

The activity has an alarm

Our scenario: You want to see how many phone calls you have tomorrow.

To view phone calls scheduled for tomorrow.

1 On the Navigation Bar, click Activities.
2 Click the My Activities tab.
3 Use the Task Pane Filters to narrow the list:

• Expand the Activity Type filter and select Phone Call.
• Expand the Time Frame filter and select Tomorrow.All of the calls you have scheduled for tomorrow

are shown in the tab.

4 (Optional) You can click the activity type to view its detailed information and make any required changes.

Viewing a History of Interactions with an Account
When responding to scheduled or unscheduled activities, you may need to view the history of interactions
with the contact and account or lead. For example, if a customer calls to ask a question she had from your
last meeting, you can open the account history to view the meeting notes. The Notes/History tab contains
all interactions, including full text notes, and provides filter options for viewing, e-mailing, and printing history
items and notes.

Our scenario: You want to review all the interactions you have had with anyone at Beeker Motor’s.

To view account history:

1 Go to Beeker Motors’ Account Detail view.
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2 Click the Notes/History tab. If the tab is not visible, click the More Tabs.
3 If necessary, click the Filter button and use the filters to narrow the list of history items.
4 Click the Type link of the history item you want to view.

Note: For more information see the "Notes/History Tab" topic in the Infor CRM SLX Web Client Help.
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Chapter 5: Communicating with Contacts and Leads

This chapter gets you acquainted with additional methods of sending information to your contacts or leads
such as proposals, letters, or memos by using the Infor CRM SLX Compose menu and Infor CRM SLX Mail Merge
for Microsoft Word add-in. You can create and edit templates, letters, and other business correspondence.
You can then use Mail Merge to merge your template to contacts, leads, accounts, or opportunities.

You can use the Outlook Integration with Infor CRM SLX to share information between Microsoft Outlook and
Infor CRM SLX when you write e-mail messages, add contacts, and schedule meetings.

In this chapter, you will learn to:

• Create a template
• Use Mail Merge to send information to contacts
• Work with Microsoft Outlook e-mail

Working with Templates
You can use templates to create letters, proposals or e-mail messages that are used for more than one contact
or lead. Templates use standard text that does not change, as well as mail merge fields that use Infor CRM
SLX information that changes depending upon the contact or lead being merged.

Infor CRM SLX Word Templates and Web Email Templates

When you install the Infor CRM SLX Mail Merge for Microsoft Word add-in, you can create, edit, or manage
Infor CRM SLX mail merge Word templates from the Microsoft Word Mailings tab. To access these features,
Microsoft Word must already be installed and configured and users must install the Infor CRM SLX Mail Merge
for Microsoft Word on page 76. For more information see, Working with Word Templates in the Web Client
help.

In the Web Client you can select an existing template and perform a mail merge with the output to file or
email. The templates used for output to email are created and managed in the Web Client while templates
used for output to file can be created, edited, and managed in Microsoft Word. For more information see,
Working with Web Email Templates in the Web Client help.

Note: Mail Merge and template management are not available for all the users.
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Creating a New Template in Microsoft Word
These instructions help you create a new private Microsoft Word template.

Our scenario: Tom Dale requested a pricing proposal for 150 motors. You need to create a new pricing proposal
template.

To create a new template:

1 In Microsoft Word, open a blank document that you want to save as a new template, and on the Mailings
tab, click Save as New Template. In the Manage Templates dialog box, click New.

2 In the empty document, type the text you want to include in the proposal template.
3 To add Infor CRM SLX merge fields to the template, place the cursor in the template where you want the

merge field to appear, click Insert Field, then from the merge field list, select a field.
The new merge field appears in the template.

4 In the Template Properties dialog box, do the following:
a In the Name field, specify Pricing Proposal.
b In the Family field, select My Templates.
c In the Main Table, select Contact.
d In the Owner field, your name must be the owner.
e In the Email Subject, type the default subject you want to use if this template is sent as an email

message. For this example, <Your company's> Pricing Proposal.
f Click OK.

Microsoft Word opens for you to create the new template.

5 To create the proposal for Tom Dale, you need to start a mail merge.
6 On the Mailings tab, click Compose Mail Merge.
7 If necessary, click the Template ellipsis button, expand Private Templates, expand My Templates, select

Pricing Proposal, and then click OK.
8 Select the Select Record option, select Contact from the drop-down list, and then click the ellipsis

button.
9 In the lookup search for Tom Dale, select the record in the list and then click OK.
10 Clear the Enforce "Do Not Solicit" option as Tom Dale requested this information.
11 Select the Attach document to each record option.
12 Click the Select Address drop-down arrow and select Mailing.
13 Click the Output Type drop-down arrow and select File.
14 Click the Directory ellipsis button and browse to the location where you want the merged file to be saved.
15 Click the File format drop-down arrow and select PDF.
16 Click the History Options tab and select the Create history for each contact or lead and Add merged

text to the history notes options.
17 For the Result, select Complete.
18 For the Regarding, select Send proposal.
19 In the Notes box type Pricing proposal for 150 motors.
20 Click the Follow-Up Options tab.
21 Select the Schedule a Follow-Up option and select Meeting from the drop-down list.
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22 Select Carry Over Notes box to carry over your notes from the history item to the follow-up activity.
23 Make sure the Timeless option is cleared and select a Start Time of next Monday at 9:00AM, click the

Duration drop-down arrow and select 1 hour.
24 Click the Reminder drop-down arrow and select 30 minutes.
25 Make sure the Leader is set to you.
26 Click the Category drop-down arrow and select Follow-up.
27 Click Merge to start the merge.

The Mail Merge In Progress dialog box shows the progress of the merge.

28 When finished, click OK to close the dialog box.
Windows Explorer opens to the Directory specified in step 12 with the merged document selected.

29 Double-click the merged document to open and view the pricing proposal.

Creating a New Email Template in the Web Client
These instructions help you create a new Email template.

Our scenario: You need to create a email template to thank customers for allowing you to demonstrate your
product.

To create a new email template:

1 On the Compose menu, click New Email Template.
The Insert Email Template page is displayed.

2 In the Name box type Thank You - Demo.
This is the name of the template that displays when  selecting an email template.

3 In the Description box type Thank you email after demo.
This is a brief description of the email template content or suggested use.

4 Click the Contact/Lead drop-down arrow and select Contact.
The properties available for contact templates are different than the properties available for leads,
therefore it is important to have separate templates designated for contacts and leads.

5 Click  Save.
6 In the Email Template detail view, click in the Body section, you can type and format text and add SLX

fields using the @mention user interface.
For this example, type:
Dear @PreferredName,
Thank you so much for allowing us to present a solution to @Contact.Account.
We feel that, together with your team, we have identified
@Contact.Account's PC needs

and recommended a package that will provide great performance and reliability for your staff.
Please let us know if you have any outstanding questions at all.
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We are working on your proposal and will have that to you shortly.
Thank you again for your time!
@Username
@Title
@UserCompany
@Userinfo.Phone
@Userinfo.M

Using Mail Merge in the Web Client
You can use Mail Merge when you need to correspond with a group of contacts or leads. Mail Merge helps you
simplify the process of sending the same information to numerous people by merging information into a
template. You can merge to a file, send an e-mail or print the merged document.

Our scenario: You recently provided a demonstration for upgrading all of your contacts at Beeker Motors,
and want to send an email letter thanking them for their time. You want to run a mail merge to send the
information to all contacts at once.

To send e-mail using Mail Merge:

1 On the Compose menu, click Mail Merge.
The Mail Merge dialog box appears.

2 On the Merge With tab, click the Entity Type drop-down arrow, select Account, and the click the

Lookup  icon.
3 In the Lookup, specify Be, click Search, and then double-click Beeker Motors in the list.
4 Click the Output Type drop-down arrow and select Email.

5 Click the Template  button, and begin typing Thank you.
6 Select Thank you - Demo from the list and click OK.
7 Leave the Primary contact only and Enforce "Do not solicit" options selected.
8 Select the Attach document to each record option.
9 Click in the Subject box and type Thank You.
10 Select the Send emails to the contact/lead email address option to use the email addresses defined

for each contact in Infor CRM SLX. Selecting this option makes the Recipients box unavailable.
11 In the CC box, type @ and then type the name of an Infor CRM SLX user, team, or department to send the

email to additional people in your organization. Or type the email address of someone who is not an
Infor CRM SLX user, contact, or lead.

12 Click the History Options tab.
13 Make sure the Create history record for each contact or lead option is selected.
14 Click the Regarding drop-down arrow and select Send e-mail message.
15 Click the Follow-Up Options tab.

Getting Started with the Infor CRM SLX Web Client | 39

 

Communicating with Contacts and Leads



16 Select the Schedule a Follow-Up option, click the drop-down arrow and select Phone Call.
17 Clear the Schedule separate follow-up activity for each contact option, as you want to schedule a

single phone call with all contacts as attendees.
18 Select a Start Time of next Thursday at 10:00AM, click the Duration drop-down arrow and select 1 hour.
19 Click the Reminder drop-down arrow and select 30 minutes.
20 Make sure the Leader is set to you.
21 Click the Category drop-down arrow and select Follow-up.
22 Click OK.

The merged emails are sent to all recipients and history records are added for each contacts. For more
information see the Using Mail Merge in the Web Client topic in the Infor CRM SLX Web Client Help.

Using Outlook Integration
Outlook Integration features are now installed with Xbar.

If your company uses Outlook Integration, you can save Outlook email messages as Infor CRM SLX history
items. For example, you can:

• Compose an email message in Outlook, select contacts from the Infor CRM Address Book, and then click
Send to CRM to record the email body and any attachments to the associated record. You can also include
attachments to the message.

• Select an email message in Outlook, and then click Record to History to record the email body and any
attachments to the associated record.

• Send an Infor CRM SLX contact's information in a vCard file format via email.
• Attach documents from Infor CRM SLX Library to a message in Outlook.
• Drag and drop email messages from Outlook to the Infor CRM SLX History tab.
• Click the Email button on the Contact or Lead Detail view to open a new email message addressed to

that lead or contact.
• Click the Email button on the Ticket Detail view to copy ticket information into a new email message,

and then click Send to CRM in Microsoft Outlook to send the message and save it to Infor CRM SLX.
Note: For more information see the following topics in the Infor CRM SLX Web Client Help:
• Emailing a Contact or Lead
• Sending an Email Message from a Ticket

Our scenario: You want to send an email to Tom Dale and Joan Smith of Beeker Motors to tell them that you
will be out of the office for a few days. You can use Microsoft Outlook and record the email message in Infor
CRM SLX.

Sending email to multiple records using Outlook Integration
To send an email to multiple records using Outlook Integration.
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1 On the Navigation Bar, click Contacts.
2 Use the Lookup to find the contacts you want to e-mail.

a Click the Lookup tab (magnifying glass).
b In the first field select Account, in the second field select Starting With, in the third field specify Be,

and then click Search.

3 Select Tom Dale and Joan Smith.
To select more than one record, hold down Ctrl or Shift, and highlight the records.

4 From the Task Pane, under Common Tasks, select Email.
5 If the Select Names dialog box opens, select both names and click To, and then click OK.
6 If email is enabled, but you have not logged on, at the message field, click Yes to log on.
7 In the Subject line, specify Out of Office.
8 In the Body area, type I will be out of the office for a few days. I’ll contact you when I return.

Since you are using Outlook to send this email message, you may want to record this to Infor CRM SLX
History.

9 Click Send to CRM.
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Chapter 6: Managing Opportunities for Sales

Opportunities are potential sales to accounts and contacts. When an opportunity progresses, you can track
the products involved in the opportunity, days in the pipeline, competitors, level of commitment by the
prospect, and much more.

In this chapter, you will learn to:

• Add an opportunity
• Use opportunity Statistics
• Close an opportunity

Adding a new opportunity
On the Insert Opportunity page, you can specify the values for a new opportunity. You can also:

• Add, edit, or remove products, competitors, or contacts.
• Update the opportunity currency and rate if Multi-Currency option is enabled.
Note: To set the default values for the opportunities, go to Tools > Options and select the Opportunities
tab.

It is not necessary to complete all information when you add an opportunity. You can add the information
that is most important to your company when you add the opportunity, and then update the Opportunity
Detail view with more information later. For example, when you add an opportunity, you may want to note
the probability of closing the sale, the dollar amount, and the estimated close date. Then add information as
the opportunity moves through the pipeline.

If you do not want to add products while adding a new opportunity, you can add them later using the Products
tab in the Opportunity Detail view.

Adding contacts to an opportunity allows you to target the individuals at the account and designate their
roles and influence in the possible sale. If you do not add contacts while adding the new opportunity, you
can add them later using the Contacts tab in the Opportunity Detail view.

Our scenario:

There is an opportunity for a sale of 10 printers to Beeker Motors. You want to create a new opportunity and
add products and contacts.

To add a new opportunity:
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1 Open the Beeker Motors' Account Detail view.
2 On the New menu, click Opportunity.
3 Specify the information:

Based on your Opportunities options, some boxes may already be completed.

Description
Enter a name for the opportunity. To help track opportunities, use the account name in the opportunity
description.

Account
Verify that Beeker Motors appears.

Account Manager
Click the Find button to find the person or team within your organization that manages the account.

Estimated Close
Click the Calendar button, select the date that the opportunity is estimated to close, and then click OK.

Type
Click the drop-down arrow, and select New.

Lead Source
Click the Find button, click Search, and select Trade Show. Click OK.

Status
Your company defines the opportunity status list. Click the drop-down arrow, and select a status from
the list.

Type
Click the drop-down arrow, and select New.

Lead Source
Click the Find button, click Search, and select Trade Show. Click OK.

Close Probability
Click the drop-down arrow, and then select the probability that this opportunity will be closed from the
list.

4 Add the opportunity products.
a In the Products section, click the Include Product button.
b From the lookup, select NetPrinter Laser Elite, click Add Selected, and then click Close.
c In the grid, click the Quantity column and change 1 to 10.

5 Add the opportunity contacts.
a In the Contacts section, click the Include Contact button.
b From the lookup, select Joan Smith and Tom Dale, click Add Selected, and then click Close.

6 Click Save.
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Using opportunity statistics
You can use Opportunity Statistics to view opportunity information at a glance. You can view opportunity
statistics for a group of opportunities, or you can select individual opportunities from the Opportunity List
view.

To open Opportunity Statistics:

1 On the Navigation Bar, click the Opportunities button.
2 In the Opportunities List view, open the group of opportunities you want to view.

You can open the opportunity group using the Opportunity Group list.

3 Select the records you want to view, and do one of the following:
• Right-click and select Opportunity Statistics.
• In the Task Pane, under Common Tasks, click Opportunity Statistics.

4 When finished, click Close.

Closing an opportunity
When an opportunity is won or lost, you should close the opportunity. For future reference and reporting
purposes, you should provide the reason for closing the opportunity.

Our scenario:

Beeker Motors has agreed to your terms and pricing and now you may close the opportunity.

To close an opportunity:

1 Open the Beeker Motor's opportunity in the Opportunity Detail view.
2 In the Status box, click the drop-down arrow, and select Closed-Won from the list.

The Close Opportunity dialog box opens.

3 In the Actual Amount box, verify the amount of the sale is listed.
4 If necessary, modify the Actual Close date. To modify the date, click the Calendar button, select a new

date, and then click OK.
5 In the Reason Won field, click the ellipsis button, select an item or items from the list, and then click OK.
6 In the Comments box, type Delivery must be complete by the end of the financial quarter.
7 Click OK.

Beeker Motors’ Opportunity Detail view appears with a Closed-Won Status and the Probability
automatically updates to 100%.

Adding an asset to an account
To add an asset to an account:
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1 Click the Beeker Motors link.
2 Click the Assets tab. If the tab is not visible, click the More Tabs.
3 Click the Add Asset button.
4 In the Add Asset dialog box, click the Name Find button.
5 From the lookup, search for and select NetPrinter Laser Elite, and then click OK.
6 In the Quantity box, type 10.
7 In the Serial Number box, type BMNPLE001.
8 Click OK.

The asset appears in the product list for that account.
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Chapter 7: Managing Leads and Campaigns

This chapter introduces you to Infor CRM SLX Marketing. With Infor CRM SLX Marketing you can develop and
qualify new sales leads, convert leads in into customer in a structures process, and create and manage sales
campaigns while tracking their effectiveness.

In this chapter, you can:

• Add leads to Infor CRM SLX.
• Import leads to Infor CRM SLX.
• Qualify a lead.
• Add a campaign.
• Add targets to a campaign.
• Add stages and tasks to a campaign.
• Add products to a campaign.
• Launch a campaign.
• Track campaign responses.

Working with Leads
Leads are unqualified potential customers. Use lead qualification criteria to determine if a lead has valid
information, already exists as a lead or contact, or is ready to be converted to a sales opportunity. Once
qualified, a lead can be converted to or merged with a contact and account. You can also create a new sales
opportunity.

Adding a Lead
There are many ways in which your company can acquire leads. They may buy lead lists, acquire another
company’s customers, or find a single lead while maintaining current accounts. If you have multiple leads,
importing the information to Infor CRM SLX is the most efficient method. However, if you cannot import lead
information, you must manually add the lead(s) to Infor CRM SLX.

Our scenario: While you were speaking to a current contact, he mentioned his friend Bob Green may be
interested in purchasing some software. You need to add Bob Green to Infor CRM SLX as an unqualified lead.

To add:
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1 On the New menu, click Lead.
2 In the Name field, specify Bob Green.
3 In the Company field, specify Green Dentistry.
4 In the Email field, specify bob.green@greendentist.mail.
5 In the Phone field, type 5553211234.
6 Click Look for Matching Records to search the database for leads, contacts and accounts that have

matching information.
The Matching Leads dialog box appears. If a matching record displays in this dialog box, you can open
the matching record to see if the lead, contact, or account is the same as the lead you are entering.

7 In the Matching Leads dialog box, click Cancel.
8 In the Title field, select or specify Managing Director.
9 In the Industry field, select Healthcare/Medical/Pharmaceutical from the list, and then click OK.
10 In the Interested In field, specify accounting software.
11 In the Lead Source field, click Find.
12 In the Lookup Lead Source dialog box, click Find, select Word of Mouth/Referral, and then click OK.
13 Click Save.

Importing Leads
Your company may purchase mailing lists or have a large number of potential customers that must be tracked
in Infor CRM SLX. Rather than adding leads one at a time, you can import large numbers of leads to Infor CRM
SLX quickly and easily.

Use the Import Leads view to import lists of leads into Infor CRM SLX. You may only import leads from a
comma-separated values (CSV) list. Valid file types include Microsoft Excel, .txt files, and other database file
types, but files must be saved as a CSV file.

Our scenario: Your manager has given you a file containing 200 leads. You want to import the leads into Infor
CRM SLX so that you can begin calling them.

To import leads:

1 From the Tools menu, click Import Leads.
2 Next to the Select a file containing Leads information to start field, click Browse, browse to the list

you want to import, and then click Open.
3 Click the Default Owner Find button to select the person or team within your organization that will own

the imported leads.
4 Click the Default Lead Source Find button and select Purchased List - General.
5 Make sure Create a new ad hoc group is selected.
6 Click Next.

The wizard moves to Step 2, Define Delimiter.

7 Preview the records before they are imported. If necessary, select a different delimiter value, for example
a comma, semicolon, or text qualifier.
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Note: For more information see the “Defining a Delimiter” topic in the Infor CRM SLX Web Client Help.

8 Click Next.
9 Match the lead list fields and Infor CRM SLX lead fields. If you want to display all of the fields in both lists

and any template, select Show All Fields.
a Select the external list field and Infor CRM SLX field to be matched.
b Click Match.

10 Repeat the previous step for each field that needs to be matched.Matched Infor CRM SLX fields display
in the Matched Infor CRM SLX Field column.

11 Click Next.
The wizard moves to Step 4, Manage Duplicates.

12 Complete the Manage Duplicates information.
a Select Check for duplicate leads..
b Next to Type, select Contact and Lead to make sure records do not already exist as a contact or lead.
c Under Match Filters, select the filter check boxes that you want to apply. For example, First Name,

Last Name, Work Phone, E-mail, Account/Company.
d For this scenario, clear the Auto-merge duplicate records option.

Note: Matched Infor CRM SLX fields display in the MatchedFor more information see the “Rules for
Automatically Merging Records During Import” topic in the Infor CRM SLX Web Client Help.

e If you want to check for duplicate records within the import source file, select the Check for duplicates
contained within the import source file option.

f Click Run the Test to run the Find Duplicates Test on the first 100 records in the import or all of the
records if you selected the previous option.
Note: For more information see the “Managing Duplicate Records” topic in the Infor CRM SLX Web
Client Help.

13 Click Next.
The wizard moves to Step 5, Select Import Actions.

14 Complete the Select Import Actions information.
Use import actions to specify actions to be performed for the leads you import to Infor CRM SLX.
a Next to the Add Note action, click Define.
b In the Add Note dialog, select Timeless, and in the Notes field specify This record was imported

from a list.
c Click Save.

Note: For more information see the “Selecting Import Group Actions” topic in the Infor CRM SLX Web
Client Help.

15 Click Next.
The wizard moves to Step 6, Review.

16 Review the import selections and click Submit.
The wizard moves to Step 7, Process Request.

17 When the import is finished, click the Import Number link to see the import history results in the Import
History view.
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Qualifying a Lead
A lead may contain unqualified information. You can use lead qualification criteria to validate information
and determine if the lead is a sales opportunity. Once qualified, you can convert a lead to a contact and
account and create a new sales opportunity.

Our scenario: You spoke to Bob Green on the phone and he has decided to order from the company. You need
to add the information regarding Bob’s purchase and convert him to a qualified lead.

Note: If the Qualification criteria was customized by your administrator, the items you see in the workspace
may be different.

To qualify a lead

1 Click Leads on the Navigation bar.
2 Click the Lookup tab (magnifying glass).
3 Use the Lead lookup dialog box to find Bob Green:

a In the Lookup by field, select Name.
b In the next field, select Starting with.
c In the third field, specify green, and then click Search.

4 In the list, click Green, Bob.
5 In the Qualification field, select Lead from the list.
6 Under Qualification:

a Select the Valid Contact check box.
b Select the Budget for purchase check box, and then in the corresponding text box specify 5000.
c Select the Timeframe for purchase check box, and then in the corresponding text box specify 3

months.
d Select the Business need identified check box, and then in the corresponding text box specify

accounting software.
e Select the Decision maker identified check box, and then in the corresponding text box specify Bob

Green.

7 Once the lead is qualified and ready to convert to a contact and account, click Convert Qualified Lead.
8 In the Convert Lead dialog box, verify that no existing contacts or accounts match the lead you are

qualifying.
9 Click Convert.

Working with Campaigns
A campaign is a combination of various advertising, public relations, sales promotion, and selling activities
used over a period of time to achieve predetermined sales or marketing goals. A campaign can target a specific
industry or group. Infor CRM SLX Marketing allows you to track information such as the time frame of the
campaign, products associated with the campaign, response rates for a campaign, and more.
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Adding a Campaign
After you have determined what type of campaign the company plans to use, you can add the information
to Infor CRM SLX.

Our scenario: the company has decided to run a return mail advertisement campaign to all leads and contacts
in the state of Illinois. You need to add the campaign information to Infor CRM SLX. This includes the campaign
targets, stages, and tasks that must be completed during the campaign.

To add a campaign:

1 On the New menu, click Campaign.
The Insert Campaign dialog box is displayed.

2 In the Campaign Name field, specify IL Return Mail Ad Q4 FY2016.
3 In the Description field, specify Return mail advertisement for IL - Fall 2016.
4 In the Objective field, specify Promote PC v7.

In this scenario, the objective of the campaign is to promote the new version of Pocket PC.

5 In the Call to Action field, specify Pre-register and save 10%.
6 In the Lead Source field, click Find, and next to Advertising - General, click Associate.
7 In the Status field, select Setup.
8 In the Code field, specify RMAdQ42016.

The code is a unique identifier for this campaign.

9 In the Start Date field, specify or select next Monday’s date.
10 In the End Date field, select a date 3 months in the future.
11 In the Manager field, click Find , select name, and click OK.
12 Click Save.

Adding Targets to a Campaign
When you identify the targets, isolate the contacts, accounts, and/or leads on which to focus the marketing
efforts. Effectively targeting the audience allows you to make the most of the marketing campaign by spending
time and money on a segment of the market most likely to purchase from the company.

To add targets to a campaign

1 On the Navigation Bar, click Campaigns.
2 Open the IL Return Mail Ad Q1 FY2016 campaign in the Campaign Detail view.
3 Click the Targets tab.
4 Click Add Targets.
5 Use the filters to narrow the list of records.

a Select Accounts (all Contacts).
b Select the State check box, select Starting with in the drop-down box, and then specify IL in the

text box.
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6 To find out how many targets meet the filter criteria before searching, click How Many?.
7 Click Search.
8 Click Add Targets to add all the targets in the list and close the dialog box.

The targets appear in the Targets tab grid.

Adding Campaign Stages
To add a stage to a campaign:

1 Open the IL Return Mail Ad Q4 FY2016 campaign in the Campaign Detail view.
2 From the Campaign Detail view, select the Stages/Tasks tab, and click Add Stage.
3 In the Description field, specify Prepare ad slick.
4 In the Status field, and select In Progress from the list.
5 In the Comments field, specify Used in-house ad department. Updated campaign previously targeted to

state of CA.
6 In the Start Date field, select today’s date.
7 In the End Date field, select a date one week from today.
8 Click OK.

Campaign tasks can help Infor CRM SLX Marketing users manage the campaigns. You can add and edit
task information, or complete a task once it is finished.

Adding Campaign Tasks
To add tasks to a campaign

1 In the Campaign Detail view, on the Stages/Tasks tab, click Add Task next to the appropriate campaign
stage.

2 In the Description field, specify Update CA ad slick from FY2011 Q4 campaign.
3 In the Status field, select Completed from the list.
4 In the % Complete field, specify 100.
5 In the Needed Date field, select yesterday's date.
6 In the Assign to section, select Other Individual.
7 In the Assign To field, specify Advertising Dept - Tom.
8 Click OK.
9 To add another task, click Add Task next to the campaign.
10 In the Description field, specify Print new ad slick.
11 In the Status field, select In Progress from the list.
12 In the Needed Date, select a date 6 days from today.
13 In the Assign to section, select Other Individual.
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14 In the Assign To field, specify Print Vendor.
15 Click OK.

Adding Products to a Campaign
Products are the goods and/or services that you are selling in a campaign. You can add products to a campaign
when you add the campaign information to Infor CRM SLX, or you can add or change product information for
an existing campaign.

Our scenario: Management wants to add an additional incentive for the campaign. You need to add additional
products to the direct mail campaign.

To add products to an existing campaign:

1 Open the IL Return Mail Ad Q1 FY2016 campaign in the Campaign Detail view.
2 Click the Products tab. If the tab is not visible, click the More Tabs.
3 Click the Associate Products button.
4 Select GoStore 200GB and Kiva Big Mouth Briefcase, and then click Add Selected.

Launching a Campaign
When all campaign information has been added to Infor CRM SLX, you are ready to launch the campaign.
Launching the campaign allows Infor CRM SLX to begin tracking information used in reports, budgets, and
so on.

When a campaign is launched, the campaign target contacts and leads are assigned to the first stage of a
campaign and their status is changed to "Launched".

Our scenario: After verifying all the campaign steps and information, you want to launch the campaign.

To launch a campaign:

1 Open the IL Return Mail Ad Q1 FY2016 campaign in the Campaign Detail view.
2 Verify all the information is correct.
3 Click Launch.

Tracking Campaign Responses
After you launch a campaign, you can begin to track the responses associated with the campaign. Campaign
responses include who responded, the date, the response method, any notes, and so on. You can track
responses during various stages of the campaign. Adding this information correctly helps your company to
identify successful campaigns and stages to aid in refining and running successful campaigns in the future.

Campaign responses can be added and viewed in the Infor CRM SLX Web Client.
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Our scenario: You need to add a response for a recent campaign. The individual has decided to purchase from
your company.

To add and view campaign responses:

1 Open the I campaign in the L Return Mail Ad Q1 FY2016Campaign Detail view.
2 Click the Responses tab.
3 Click the Add Campaign Response button.
4 Select Contact, click the Contact FindL Return Mail Ad Q1 button, specify st.
5 Click the Search button, select the first name in the list, and then click OK.
6 Click the Response Method drop-down arrow and select Phone.
7 In the Comments field, type Responded within 5 days. Qualifies for 10% discount and free carrying

case.

8 In the Products section, click Add Product, click Search, select Kiva Big Mouth Briefcase, and then click
OK.

9 Click OK.
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Chapter 8: Working with Customer Service and Support

This chapter introduces you to the Infor CRM SLX Customer Service and Support features. The Customer
Service and Support features allow designated users to track, qualify, and resolve customer questions and
issues.

In this chapter, you can:

• Understand and work with contracts
• Add, work in, and close tickets
• Add and close a return
• Add and close a defect

Working with Contracts
Contracts are agreements between accounts and the company to provide support for products sold. Infor
CRM SLX has five general types of contracts that cover support services. In addition, a contract can cover a
specific set of products, or it can be a “blanket” contract that covers all the products, which the account owns.
You can use contracts to verify that support is provided to specific accounts for specific products.

Understanding Contract Types
The five default contract types are:

DescriptionType

The contract is tracked according to a number of days of services the account has purchased.
This value is entered into the Quantity box for the contract. When the contract type is Days,
and as activities are generated for the account, the value in the Remaining box will not
decrement.

Days

The contract is tracked according to a number of hours of services the account has purchased.
This value is entered in the Quantity box for the contract. The total time is calculated using
the Elapsed Hours value for all activities generated for the account. As activities are generated,
the value in the Remaining box decreases to reflect the number of hours left on the contract

Hours
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The contract is tracked according to the number of service calls the account has purchased.
This value is entered into the Quantity box for the contract. The total number of incidents
reflects the total number of tickets the account has opened. As tickets are opened, the value
in the Remaining box decreases to reflect the number of incidents left on the contract.

Incidents

The contract is tracked according to a currency value placed on the services the account has
purchased. This value is entered into the List Price or Contract Amount box for the contract.
When a ticket activity is created against the contract, the activity's Total value is charged
against the contract amount, and the value in the Remaining box decreases to reflect the
value left on the contract.

Value

The contract has no limit. The account can open an unlimited number of tickets and activities
for an unlimited amount of time.

Perpetual

To ensure that the time, number of incidents, or currency value left on a contract is tracked accurately, you
must activate the contract before beginning work on a ticket.

Adding a Contract
Each contract you add must be connected with an account that already exists in Infor CRM SLX. The following
scenario explains how to create a contract for an account.

Our scenario: Tom Dale calls to request a new contract. He wants a one year contract that covers up to 10
incidents.

To add a contract:

1 Open the Beeker Motors Account Detail view and select the Contracts tab. If the tab is not visible, click
the More Tabs tab.

2 Click Create Contract.
3 Complete the contract information fields.

a In the Reference #, specify a reference number for the contract.
b Verify that Dale, Tom is listed in the Contact field. If not, click Find and select Tom Dale from the

lookup.
c Select Active.
d In the Comments field, specify New 1 year contract for 10 incidents. Qualifies for new customer

discount.
e Select Classic Care Ultra from the service list.
f Select Incidents from the Contract Type list.
g Leave the Start Date as today's date.
h Type a purchase order number in the PO Number field.
i In the Purchase Date field, select today's date.
j In the List Price, specify 500.00.
k In the Discount field, specify 50.00 because he qualifies for a new customer discount. The Contract

Amount is automatically calculated.
l For Expiration, click the Calendar button and select the date one year from today.
m In the Quantity field, specify 10. This specifies that the contract covers 10 incidents in the next year.
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4 Click Save.
5 Associate Beeker Motors assets to the contract.

a On the Contract detail view, click the Covered Assets tab. If the tab is not visible, click the More Tabs
tab.

b Click Associate Asset.
c In the lookup select NetPrinter Laser Elite, and then click Add Selected.

Working with Tickets
Tickets are records of customer inquiries or complaints. They can contain the information necessary to report,
investigate, and close an inquiry or problem. You can insert new tickets for an account or contact, track your
time spent resolving issues for a ticket against a contract by using the Punch In/Punch Out button record
calendar and other activities for a ticket, and search for existing tickets using the Lookup. In addition, you
can use Speed Search to search for existing problems and their resolutions that may apply to the ticket's
issue. Before you add a ticket, the account and contact must exist in Infor CRM.

Adding a Ticket
Our scenario: Tom Dale at Beeker Motors called. He is having a problem with one of their printers and needs
the problem resolved by the end of the week. You need to create a ticket to work on the problem.

To add a ticket

1 Open Tom Dale’s Contact Detail view.
2 On the New menu, click Ticket.
3 In the Insert Ticket view, verify Beeker Motors appears in the Account field.
4 If required, in the Contact field, click Find, and then select Tom Dale.
5 In the Contract field, click Find, use the Lookup Contract to select the contract you created in the

previous scenario, and then click OK.
6 In the Source field, and select Phone from the list.
7 In the Area field, click Find and in the Area list select Hardware.

Options available for Hardware appear in the Category list.

8 In the Category list, select Printer.
9 In the Issue list, select Power, and then click OK.
10 In the Status field, and select In Process from the list.
11 Select Med-High from the Urgency list.
12 In the Needed Date field, use the Calendar to select a date at the end of the week.
13 Verify the Assigned To field lists the name. If required, click Find and select the name from the list.
14 In the Subject field, specify a short summary of the problem.
15 In the Description field, click the Date/Timestamp, and specify detailed information for the problem.
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16 Under Comments, in the Internal field, click Date/Timestamp, and specify additional information that
is important to the ticket.

17 Click Save.

Adding Ticket Activities
Ticket Activities are added through the Ticket Activities tab on the Ticket Detail view. Ticket Activities enable
you to track the time, the types of tasks, and any associated costs involved in resolving a ticket. Activities are
recorded by activity type and charge rate and are used for billing the customer against their service contracts.
You can add your own ticket activities at any time from the Ticket Activities tab.

Our scenario: You told Tom Dale that you will research his problem and call him back. You need to add a ticket
activity for the research time.

To add a ticket activity:

1 Open Tom Dale's ticket.
2 Click the Ticket Activities tab. If the tab is not visible, click the More Tabs tab.
3 On the Ticket Activities tab, click Advanced.

The Insert Ticket Activity view opens.

4 In the Type field, select Research from the list.
5 In the Public Access field, click the drop-down arrow and select 1-Customer.

This setting determines whether customers are able to see the ticket activity using Infor CRM SLX Customer
Portal.

6 Verify that the Start Date field displays the correct start date and time for the activity. If not, click Calendar
to specify the correct date and time.

7 Since you have not yet completed the activity, skip the End Date field. When you complete the activity,
you can use the Calendar to select the date and time you finished working on the activity.
It is very important that you select accurate dates and times in both the Start Date and End Date boxes
because this information is used to calculate the Time Units, Elapsed Hours, Rate, and Total Labor.

8 Verify that the User field displays the name. If not, click Find to locate the name or the name of the
individual who are responsible for completing the activity.

9 (If required) In the Charge Type field, click Find, select No charge, and then click OK.
The charge type is the rate your company charges against the customer’s support contract for the work
you performed.

10 n the Comments field, specify Research printer power issues.
11 Click Save.

Note: For more information see the "Adding and Editing Ticket Activities" topic in the Infor CRM SLX Web
Client Help.
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Punching In and Out of a Ticket
The Punch In and Punch Out function enables you to track the time spent assisting a customer for each ticket.
When you click the Punch In button on a ticket's detail view, Infor CRM SLX begins timing the activity. When
you are finished, you can click Punch Out. Infor CRM SLX stops timing the activity and adds an activity record
to the Ticket Activities tab for the ticket.

Note: When you use the Punch In/Punch Out feature in a ticket, a timed activity is automatically created.

Our scenario: Tom Dale calls with more information on his printer problem. You need to open the ticket and
track the time you spend talking to him and gathering information.

To punch in to and out of a ticket:

1 From the Beeker Motors Account Detail view, click the Tickets tab, and click the ticket’s Ticket ID number.
2 Click Punch In.

The button text changes to Punch Out, and Infor CRM SLX begins recording time against the ticket activity.

3 Click the Ticket Activities tab. If the tab is not visible, click the More Tabs tab
4 From the list of ticket activities, click Edit next to the Timed activity you want to change.
5 Enter the information from the conversation with Tom Dale in the Comments.
6 Click Save.
7 When you are finished working on the ticket, click Punch Out to stop tracking time on the ticket.

Closing a Ticket
The stage at which a ticket is closed and the person responsible for closing a ticket depend on your company’s
processes.

Our scenario: You resolved the problem with Tom Dale’s printer and completed all follow-up activities. Now
you want to close the ticket.

To close a ticket:

1 Open Tom Dale's ticket.
2 Ensure all ticket information is complete and accurate.
3 Close any open ticket activities.

a Click the Ticket Activities tab.
b Click Edit next to the Research activity.
c Click End Date Calendar, select a date, and then click OK.
d Click Save.

4 In the Status field, select Closed from the list.
5 Click the Details tab and update the Resolution.

a Click Date/Timestamp.
b Specify Printer overheats and turns off due to faulty fan.
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6 If you want to submit the resolution information to be accepted into the SpeedSearch indexes, select
the Submit for SpeedSearch check box in the top pane.

7 Click Save.

Working with Returns
Returns are agreements to accept returned products from a customer for service, replacement, refund, or
credit. This may also be referred to as an RMA or Return Materials Authorization.

Adding a Return
Every return must be associated to a ticket. Before you add a return, ensure that the related ticket exists. If
necessary, create the ticket before proceeding.

Our scenario: Tom Dale reported a problem with a printer and sent it in for repairs. After researching the
ticket, you determined that the printer must be replaced.

To add a return

1 Open Tom Dale's ticket.
2 Click the Returns tab. If the tab is not visible, click the More Tabs.
3 Click the Insert New Return button.
4 Verify that the Ticket ID, Account, and Contact are correct.
5 In the Reason field, type Printer overheats.
6 In the Customer PO field, type the customer purchase order.
7 Click the Status drop-down arrow and select Return Received.
8 Click the Type drop-down arrow and select Send Replacement.
9 Click the Priority drop-down arrow and select Next Day.
10 In the Expected By field, click the Calendar button, and select this Friday.
11 Click Save.

The Return Detail view opens.

12 Click the Ship To Details tab. If the tab is not visible, click More Tabs.
13 Verify the contact and address information is for Tom Dale at Beeker Motors.

Adding Products and Shipping Details to a Return
You add products to a Return to indicate which product the account is returning, and which is the replacement
product to be shipped to the customer.
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Our scenario: You added the return for Tom Dale's ticket and now want to add the product asset that Tom is
returning.

Adding Asset to a Return
To add an asset to a return:

1 Open the detail view for the return you created for Tom Dale's printer.
2 Click the Details tab. If the tab is not visible, click More Tabs.
3 In the Assets to Return section, click the Associate Asset button.
4 Locate and select the NetPrinter Laser Elite printer using the lookup.
5 Click OK.

Updating Shipping Contact Information
To update the shipping contact information

1 Click the Ship To Details tab. If the tab is not visible, click More Tabs.
2 Verify that Tom Dale is the Contact.
3 Use the Ship Via and Tracking # fields to include additional shipping information.
4 In the Attention field, specify Tom Dale.
5 Verify that the address information is correct.
6 Specify any special shipping instruction in the Special Instructions field.
7 Click Save.

Adding products to return or replace
To add the products to be returned and replaced

1 Under Assets to Ship, click Add Return Shipped Product.
2 In the Add Return Shipped Product dialog box, under Received Product, click the Find button, select

NetPrinter Laser Elite printer, and then click OK.
3 Select Return Existing.

The returned product is automatically added.

4 Click the Shipped DateCalendar button and select today's date.
5 Click OK.
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Closing a Return
The stage at which a return is closed and the person responsible for closing the return depend on the process
within your company. As an example, when the product has been returned by the customer and the
replacement product has been shipped, that might be the stage at which you would close a return.

Our scenario: Now that Tom Dale's replacement printer has been shipped to him, you want to close the return.

To close a return

1 Open the detail view for the return you created for Tom Dale's printer.
2 In the Status field, click the drop-down arrow, and then select Closed from the list.
3 Click Save.

Working with Defects
A defect is a record describing a problem in a product or process. It is similar to a ticket, but people involved
in the design or construction of the product typically resolve defects. The system tracks defects so that
problems with a product or process can be resolved in a timely manner, and company management is aware
of issues with these products or processes.

Adding a Defect to an Existing Ticket
When you discover a problem in a product or process, you can add a defect to Infor CRM SLX.

Our scenario: After receiving Tom Dale’s printer you discovered that there is a defect with the cooling fan.
You need to enter a defect to track the problem.

To add a defect to an existing ticket:

1 Open Tom Dale's ticket.
2 Click the Defects tab. If the tab is not visible, click More Tabs.
3 Click the Create Defect button.
4 Click the Project drop-down arrow and select Hardware.
5 In the Version Found field, click the drop-down arrow, and select 1.
6 In the Target Version, click the drop-down arrow, and select 2.
7 In the Current Progress field, click the drop-down arrow, and select Customer Return.
8 In the Priority and Severity fields, click the drop-down arrow, select the importance and impact of the

issue.
9 In the Frequency field, click the drop-down arrow, and select Weekly.
10 In the Type field, click the drop-down arrow, and select Power.
11 In the Area field, click the Find button and in the Area list select Hardware.
12 In the Category list, select Printer.

Getting Started with the Infor CRM SLX Web Client | 61

 

Working with Customer Service and Support



13 In the Issue list, select Power, and then click OK.
14 Leave the Status as Open.
15 In the Source field, click the drop-down arrow, and select Parts.
16 Select the Submit for SpeedSearch option so that this issue can be found using SpeedSearch.
17 Click the Assigned To Find button , select your name from the list, and then click OK.
18 In the Public Access field, select 5-internal.
19 In the Subject specify Printer fan stops and printer overheats.
20 In the Description field, click the User Date Stamp button, and then specify Cooling fan stops which

causes the printer to overheat and turn off during a print job.
21 Click Save.

Closing a Defect
The stage at which a defect is closed and the person responsible for closing the defect depend on the process
within your company.

Our scenario: The problem with the NetPrinter Laser Elite fan has been identified. You are ready to add a
resolution and close the defect.

To close:

1 Open the defect you created for the NetPrinter Laser Elite.
2 In the Fixed in Version field, click the drop-down arrow and select an item from the list.
3 In the Status field, click the drop-down arrow, and then select Closed.
4 Click the Details tab.
5 In the Resolution field, click the User Date Stamp button, and then type Fan is too small. Any printers

experiencing this problem should be returned and the fan will be replaced.

6 Click Save.
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Chapter 9: Using Web Reporting and Analysis Tools

Infor CRM SLX is powered with reporting and analysis tools which assist you identify opportunities and evaluate
sales effectiveness.

The Reports List view provides a list of pre-defined sample reports which enable you to view and analyze
information in the Infor CRM SLX database. You can run reports related to Main views such as Contact, Account,
Opportunity and so on. You can also modify the report to accommodate your business needs. The specific
reports available to you are determined by your system administrator. The Dashboard is a tool set that allows
you to display and interact with a variety of performance and analysis information

In this chapter, you will learn to:

• Use the Reports view
• Run a report
• Export and print reports
• Work with Dashboards
• Use Dashboard widgets

Using the Reports View
Reports enable you to view information about contacts, accounts, opportunities, tickets, and other related
data.

The Reports view allows you to select from a list of available sample reports and apply filters to narrow the
results. You can only access reports that have been released to you by the system administrator. Reports can
be released to you personally, or to a team that you are a member of. When you view or print any report, only
records you have access to are included in the report.

Our scenario: You want to run a report listing all the interactions you have had with your contacts.

To run a report:

1 On the Navigation Bar, click Reports.
2 In the Report list view, Reports tab, select the Contact Summary - Sample report, right-click, and then

click Run.
This is the option for reports you want to run only once, or reports you require immediately.

3 In the Select Records dialog box, in the Show records that match field, pick All Records.
4 Click Next.
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5 In the Enter Values dialog box do the following:
• Leave View Notes as Yes.
• Use the pick list to change Start each contact on a new page to No.

6 Click Next.
7 In the Export Options dialog box, use the pick list to select PDF as the file format for your report.
8 If you selected Schedule in step 1, you can create a job schedule for running your report. Select from the

available scheduling options.
9 Click Finish.
10 When the progress message box appears, do one of the following:

• Wait for the job to complete and open your report from the link that displays.
• Click Close to dismiss the box. The report continues to process in the background. When the report

is available, a job notification alert appears in the menu bar. You can either view the report from the
Job Notifications box or from the Reports History tab.

Viewing, Printing, and Storing Reports
When you run a report, it is stored in the Reports History tab until you choose to delete it. From this tab you
can see history for the report, open the report, print, save the report elsewhere, or store the report for future
reference.

• To find the Report History tab:
1 On the Navigation bar, click Reports.
2 In the Report List view, click the History tab.

• To open a report: In the Report History tab, in the Report column, click the report name. The report
opens in the native application for the report file type.

• To print or save the report: Use the tools available in the native application.
• To delete a report:

1 In the Report History tab grid, select the report.
2 Right-click and then click Delete.

Working with the Dashboard
The Dashboard allows you to display and interact with a variety of performance and analysis tools on the
Welcome page of the Infor CRM SLX Web Client. You can maintain one or more personalized dashboard tabs
and, with the appropriate permissions, you can modify dashboards provided by Infor CRM SLX or customized
by your administrator.

You can format the data on the dashboard using widgets to gain insight into organizational and individual
performance. The data can be visualized in a pie, bar or column chart, pipeline, or line graph, or you can view
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the detailed data in a list. A widget is a dynamic, reusable element of the interface that displays the data you
specify. For more information about widgets, Refer to Working with Widgets on page 66.

There are two out-of-the-box dashboard tabs: My Dashboard and Sales. Each tab has several out-of-the-box
widgets. You can add and edit widgets to display different data or display the same data in different ways.

To open the dashboard: On the Navigation Bar, click Dashboard.

Customizing Your Dashboard
Use the context menu on a dashboard tab to add a new tab, copy, hide/show and delete tabs, or share tabs
with your team or department. Use drag-and-drop to rearrange the widgets on the tab. Widgets automatically
size to fit the data and chart type, as well as the column size.

You can also send all the data for a group from a list view to a group list widget on the dashboard with the
Promote to Dashboard link.

• To add a new tab:
1 On the Dashboard menu click New Tab.
2 In the Name field, specify a name for the tab.
3 Click Save.

• To share a tab with other users:
1 Select the tab you want to share and on the Dashboard menu, click Share Tab.
2 Do one of the following:

• To add users, teams or Everyone, click the Share with Add button, click the drop-down arrow
and select Everyone to share the tab with all Infor CRM SLX users, or the user or team you want
to share the tab with, and then click Save. Repeat until you have added all users or teams you
want to have access to your dashboard.

• To change a user or team, click the Edit icon next to the user or team you want to change, click
the drop-down arrow and select Everyone to share the tab with all Infor CRM SLX users, or the
user or team you want to share the tab with, and then click Save.

• To remove a user or team, click the Delete icon next to the user or team you want to remove.

• To promote a group to a dashboard:
1 From a list view, click the group tab you want to send to the dashboard.
2 In the Task Pane, click Promote to Dashboard.
3 Click the name of the dashboard where you want to send the data, and click OK.
4 Click OK.
5 Click Welcome in the Navigation Bar and select the dashboard tab you selected in step 3.

The data appears on the dashboard in a group list widget. The default configuration for the group
list is 10 lines; however you can change this in the widget editor to display up to 50 lines.
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Working with Widgets
Widgets are plug-ins you can add to a dashboard. There are several types of widgets you can use to display
your data. Move your mouse over the chart in a widget to display the dimension and metric selected for that
widget.

There are several types of widgets:

• Charting - Bar, Column, Funnel, Line, and Pie charts
• List - Group, Links, and Recently Viewed
• Other - Today's Activities and Welcome
Note: The list of available widgets is determined by your implementation. You may not have access to all
widget types.

Using Widgets
You can add, edit, and remove widgets from the dashboard, and you can rearrange widgets on the page with
drag and drop.

• To add content to a widget:
1 Select the tab you want to add a widget to and on the Dashboard menu, click Add Widget.
2 On the Add widget dialog box, click the widget you want to add.
3 Configure the widget settings, and click Save.

• To edit a widget:

1 Find the widget you want to edit and click the  button to open Widget Settings.
2 Make the required changes.
3 Click Save.

The widget displays the changes.

Adding Funnel Chart Widget
Our scenario: You want to show potential revenue of opportunities in your pipeline for each level of revenue.

To add a funnel chart widget:

1 Select the tab you want to add the funnel chart widget to and on the Dashboard menu, click Add Widget.
2 Click Funnel Chart.
3 Complete the Widget Settings:

Width:
Use the slider to indicate how much horizontal space the widget should occupy on the dashboard. The
default is 12. Moving the slider to the left will allow more than one widget to occupy the same line until
a total of 12 is reached.
For example, for 2 widgets to appear next to each other, set each widget’s width to 6. For 3 widgets to
appear next to each other, set each widget’s width to 4.

Getting Started with the Infor CRM SLX Web Client | 66

 

Using Web Reporting and Analysis Tools



Height:
In pixels, specify the vertical space the widget should occupy on the dashboard. The default height is
450px. To make the widget occupy more vertical space specify a higher number. To make the widget
occupy less vertical space specify a lower number.
Title:
Type the title to be displayed in the widget title bar. For example. Open Opportunities.
Subtitle:
If desired, type the text that displays below the title to provide additional information about the widget.
By default this is blank.
Subtitle:
If desired, type the text that displays below the title to provide additional information about the widget.
By default this is blank.
Limit:
Specify a numeric value for the maximum number of items to be displayed in the funnel chart. The default
is 10. Depending on the selected Dimension, a limit may not apply.

4 In the Data Sources section click the Add button.
5 In the Name box type a descriptive name for the data source.
6 In the Entity list select Opportunity.
7 In the Group list select All Open.
8 In the Dimension list select Stage.
9 In the Metric list select Sum Sales Potential.
10 Click the Sort Order drop-down arrow to select the order in which data will be arranged in the widget.

Options include: Dimension Ascending, Dimension Descending, Metric Ascending, and Metric Descending.
Select Dimension Ascending.

11 Click Save.
A range of sales potential amounts displays with each sales potential range represented as a different
colored level. The size of each level represents the number of opportunities within a particular sales
potential range.

Working with List View KPIs
The list views contain Key Performance Indicators, or KPIs. The KPIs are based on the current list of records,
the group and any applied filters. Some KPIs can be specific to a subset of data, for example in the
Opportunities list view, a KPI for Average Actual Amount can be calculated using the actual amount for all
closed-won opportunities in the list and a count of closed-won opportunities.

The list views display KPIs if a KPI is selected. These list views contain out-of-the-box KPIs to select from:

• Accounts
• Opportunities
• Quotes
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• Sales Orders
• Invoices (Infor CRM SLX Back Office only)
• Contracts
• Returns
• Tickets

Managing list view KPIs
To manage list view KPIs:

1 Click the Manage KPIs icon on the list view..
2 Select the check boxes of the required KPIs to show and clear the check boxes of the KPIs to hide.

Note: Selecting a large number of KPIs to display can increase the loading time for KPIs and decrease
the amount of horizontal space for each KPI.

3 Click Save.
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Chapter 10: Setting User Options

Infor CRM SLX provides tools which allow you to modify some parts of the interface so that you can work in
best interface which suits you. User Options allow you to set specific preferences for such features as the view
that appears when you start the Infor CRM SLX Web Client and Alerts. User specific settings are only applicable
to your Infor CRM SLX account. Some options are shared between the Infor CRM SLX Client and Infor CRM SLX
Web Client.

General Options
On the General tab you can specify default settings for which view opens by default when you first log into
Infor CRM Web Client, and the default owner for new records created.

To set general options:

1 From the Tools menu, click Options.
2 Click General tab.
3 From the Show on Startup box field, select the default view you want to display when you log in to the

Web Client, (for example, What's New or Calendar).
4 In the Default Owner/Team field, click  and select a user or team which you wish to set as the default

owner for new accounts, and click OK.
5 For Multi-Currency only: To select a currency type, click  on My Currency field and select a currency

from the list, and click OK.
6 To get updated pick list data, click Refresh Pick List Data. This button should be clicked only if updated

pick list items available. For example, the Opportunity Status pick list has been updated.
7 To get notifications about unsaved changes on a page, select Prompt for unsaved data check box. Clear

this check box to stop notifications about unsaved changes.
Note: This option is selected by default:

8 Select the Default Username/Time Stamp in Memo Fields to create an option to click the User Date
Stamp button to add your name, the date, and time (according to your language settings) to a memo
box. This option will work only on those memo boxes for which your administrator has turned this feature
on.

9 Select the Display List view check boxes check box to include a column of check boxes in all the list
views.
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10 To automatically log off Infor CRM SLX Web Client after a period of inactivity, select the Enable Automatic
Logoff check box. Specify the allowable number of minutes of inactivity in the Log off after field, after
which the Infor CRM SLX Web Client should log off.

11 In the Contact Sync Group field, select an ad hoc contact group which contains a contact list to be be
synchronized. If the desired ad hoc group is not present in the list, you must create the group. Do not
select a contact sync group if you are only synchronizing with Outlook using Outlook sync. If you are
using Outlook sync, refer to "Configuring the Contact Sync Group" in the Infor Cloudsuite CRM Web Client
Help.

12 In the Log to History field, select Prompt if you wish to view the Complete E-mail dialog box to be displayed
after you drag and drop an e-mail message. If you wish to record the message to history without prompting,
select Do Not Prompt.
Note: This option applies only to drag and drop e-mails. You must set options for Send to CRM and Record
to History in Outlook. Refer to Configuring Outlook Integration on page 20.

13 To install the Infor CRM SLX Mail Merge Microsoft Word add-in, click Install Mail Merge for Microsoft
Word.

14 To install Xbar for Outlook, click Install Xbar for Outlook.
15 For Offline Web Client users only: To run reports while offline, ensure the Use ActiveReporting check

box is selected.
16 Click Save. You must click Save on each tab else your selections will not be saved.

Group Options
On the Groups tab, you can specify the default view for groups, list views and defaults. These options apply
only when the current user is signed in to the Infor CRM SLX Web Client.

To set group options:

1 From the Tools menu, click Options.
2 Click the Group tab.
3 Set your Group Options.

a Click the Main View field and select a view from the list.
b Click the Default Group field and select a default group from the list. For example, Latest Contacts.

Note: The default layout for new groups is determined by the group selected as the default group.
If your default group does not display as a tab, you must mark it as a Favorite in the Groups list.

c Click the Default Lookup Layout field and select the name of the group with the layout you want
to see for any lookups on that main view. For example, on the Contact views, all lookups will use the
Latest Contacts group layout.
The group you select will also determine what search items are available in the Lookup. The Lookup
by options depend on the columns included in the layout of the lookup. You should choose a group
that includes all of the columns you may want to search by in a lookup.

d Repeat steps a, b and c for each main view.

4 Under General Lookup Options, click the Default Lookup Condition field and select the lookup condition
you wish to use for all list view lookups. Options are: Starting With, Contains, Equal to, and Not Equal to.
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5 Click Save.
You must click Save on each tab or your option selections are not saved.

Activities Options
On the Activities tab, you can set default settings for activities.

To set activity options:

1 On the Tools menu, click Options.
2 Click Activities tab.
3 In the Default Follow-up Activity: field, select the type of activity to be scheduled as a follow-up, after

you complete an activity.
4 In the Carry Over Notes: field, select Yes if you wish to carry over existing notes, when you schedule a

follow-up activity.
5 In the Carry Over Attachments: field, select Yes if you wish to carry over existing attachments when you

schedule a follow-up activity.
6 Select Display Past Due in the toolbar check box if you want to be notified about past due activities.
7 Under the Defaults Per Activity Type: section, set the Default Alarm and Default Duration for each activity

type:
a Click the Default Alarm field and select a time frame from the list to set the default alarm while

scheduling a new meeting.
b Click the Default Duration field and select a time frame from the list to set the default duration while

scheduling a new meeting.
c Select the Default Timeless check box if you wish to set an activity as timeless, by default.
d After selecting the Default Timeless check box, if you wish incomplete activities to automatically

rollover on the scheduled date, then select the Auto Rollover option.
Note: You can only rollover timeless activities.

e Repeat steps a-d for Phone Call, To Do, and Personal Activity.

8 Click Save.
You must click Save on each tab or your option selections will not be saved.

Calendar Options
Calendar Options allow you to adjust the content and appearance of your calendar to accommodate the way
you work. You can set the type of information that displays in activities, the start and end of the work day,
the default calendar view, default interval on the calendar, and whether or not completed activities (history)
items display. by default, history items are displayed only on the day and week calendars.

To set calendar options:
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1 From the Tools menu, click Options.
2 Click the Calendar tab.
3 In the Default Calendar View: field, select the default calendar view, to be displayed when you open the

Calendar view.
4 In the Number of Events on Day/Week: field, select the maximum number of events you wish to be

displayed in the top section of the Calendar Day and Week views.
5 In the Show History on Calendar: field, select Yes to display history items. Select No to hide history items

on the Calendar Day view.
6 In the Remember Selected Users: field, select Yes if you wish to display multiple users on your calendar

view and save the list of users between sessions.
7 Under Work Week, select the days of the week that are included in your work week.
8 Set the following options to customize your calendar:

First Day of the Week
Select the day on which your work week starts.

Day Start
The time when your workday begins.

Day End
The time when your workday ends.

Default Interval
The default interval to display the calendar information. This value can be 15, 30 or 60 minute intervals.

Default Activity Type
The default activity type. This is the type of activity that will be created when you double-click on any
of the Calendar views.

Contact/Account
Indicates how the contact and the account information is displayed on the Calendar. This option does
not apply to the month views.

Show on Activities
Select the check box to define how activities are displayed on the Calendar timeline for day and week
views. These options do not apply to the month view.
• Opportunity: Displays an activity's opportunity information, if applicable, on the day and week

calendar views.
• Phone Number: Displays an activity's phone number information on the day and week calendar

views.
• Regarding: Displays an activity's regarding information on the day and week calendar views.
• Time: Displays the activity's start and end times on the day and week calendar views.

9 Click Save.
You must click Save on each tab or your option selections will not be saved.
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Alerts Options
On the Alerts tab, you can set default settings for alarms and unconfirmed activities.

To set alerts options

1 On the Tools menu, click Options.
2 Click the Alerts tab.
3 Select Display in toolbar check box, if you wish Alerts icon to be displayed in the toolbar

Note: If you do not select this option, the remaining check boxes will be greyed out and you will not be
notified on Alerts.

4 Select Prompt for Alerts check box, if you wish to view the Alerts dialog box, every time a new alert
appears.

5 Next to Include, select the information you wish to include in your Alerts. If you have selected the Prompt
for Alerts check box, this information open the Alerts dialog box to open:
Note: If you do not select any options, but select either Display in toolbar or Prompt for Alarms checkbox,
Alerts will be empty and you will not be prompted.
• Select Alarms if you wish alarms to display in your Alerts.
• Select Unconfirmed Activities check box, if you wish to view unconfirmed in Alerts.

6 Click the Default Snooze field and select a time frame which will be set as the default amount of time to
postpone an activity alarm. You can still change the snooze time from the Snooze list before you snooze
your alarms.

7 Click Save.
You must click Save on each tab or your option selections will not be saved.

Opportunity Options
On the Opportunities define the default settings for the new opportunities created in the Infor CRM SLX Web
Client. These settings are applicable, only when the current user is signed in to the Infor CRM SLX Web Client.

To set opportunity options:

1 From the Tools menu, click Options.
2 Click Opportunities tab.
3 In the Opportunity Description area, select Use default naming conventions check box to allow the

script to control the default names of the opportunities. The sample Description field displays the sample
name of the opportunity specified by the script. Contact your administrator to ensure if you must select
this check box.

4 In the Set estimated close date to x months after opening field, select the number of monthsto set the
estimated close date for the new opportunities. You can select a value from 0 to 36.

5 Select the Initially change estimated close to last day of month check box to close the opportunities
at the end of the month selected in the Set estimated close date to x months after opening field.
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6 In the Opportunity Status field, select the default status of an opportunity. By default, this field is set
to Open.

7 In the Opportunity Type field, select the default type of an opportunity. By default, no value is selected.
8 In the Probability field, select the default probability of close for new opportunities. The application

does not consider this value if the Sales Process field is set to a value other than None.
9 To automatically include new opportunities in forecasts, select the Add to Forecast check box. Clear

this check box if you do not want to automatically include new opportunities in forecasts. You can also
manually select the Add to Forecast check box when adding or editing an opportunity.

10 For Multi-Currency only: Click the Default Currency Find button to select from the list.
11 In the Sales Process field, select the default sales process for the opportunities. The list consists of all

released sales processes. By default, this field is set to None.
Note: The Default Sales Process box will be unavailable if the Advanced bundle is not installed.

12 In the Default Contact(s) section you can select the default contacts that must be added to new
opportunities The Contact options are:
• Add all contacts associated with account
• Add only the account's primary contact
• Add no contacts

13 Click Save.
You must click Save on each tab or your option selections will not be saved.

Changing Your Password
You can change the password with the Options in the Infor CRM SLX Web Client.

To change the password:

1 On the Tools menu, click Options.
2 Click the Password tab. specify password in the Current Password field.
3 In the New Password field, specify new password.
4 Retype the new password in the Confirm Password field.
5 Click Save.

User Profile Options
On the User Profile tab, you can control the appearance and behavior of Infor CRM SLX Web Client. These
options apply only when the current user is signed in to the Infor CRM SLX Web Client.

To set user profile options:

1 From the Tools menu, click Options.
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2 Click User Profile tab.
3 If required, change the language settings.

When you change the default language in Infor CRM SLX Web Client, Infor CRM SLX is displayed in your
selected language. The list of languages depends on the languages supported by your organization.
• Click the Language Selection field and select a language from the list.

4 Click Save.
You must click Save on each tab or your option selections will not be saved.

Setting Customer Service Options
Customer Service tab allows you to set date and time stamp settings and time tracking options.

To set calendar options:

1 From the Tools menu, click Options.
2 Click Customer Service tab.
3 Under Time Tracking, perform the following tasks:

a To track the processing time elapsed on a new issue, select Automatically Punch In to a new Ticket
check box.

b To track the processing time elapsed on an existing issue, specify the time elapsed (in minutes) in
the Prompt to Punch In to an existing Ticket field.

c Select Display Ticket Activity on Punch Out check box to display the Edit Ticket Activity dialog
box to specify activity information when punching out of a ticket.

d Select Display Ticket Activity on completion of Calendar Activity (WIndows version only) check
box to display the Edit Ticket Activity dialog box to specify the activity information for a completed
calendar activity.
Note: This option only applies to the Windows Client.

4 Click Save.
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Installing Infor CRM SLX Mail Merge For Microsoft Word

Infor CRM Mail Merge for Microsoft Word provides support for Mail Merges.

Note: If you have installed a previous version of the Infor CRM SLX Mail Merge for Microsoft Word add-in, you
must uninstall the previous version of Infor CRM mail merge for Microsoft Word before installing the latest
version.

To install Mail Merge for Microsoft Word:

1 Close Microsoft Word.
2 In the Infor CRM SLX Web Client, click Options on the Tools menu.
3 Select the General tab.
4 Click Install Mail Merge for Microsoft Word.
5 Open the InforCRMWordAddinSetup.exe from your Downloads folder.
6 Select the I agree to the license terms and conditions check box.
7 Click Install. The default install location is: C:\Users\username\AppData\Local\Infor.CRM.Word.Addin
8 Click Yes to confirm the install the required add-in.
9 Click Close.
10 Open Microsoft Word.
11 If prompted, click Install on the Are you sure you want to install this customization? window.
12 Set up the Infor CRM options after installation.

• Click Infor CRM Options on the Mailings tab.
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